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INTRODUCTION

Welcome to Open Book: the Ruby Edition. Open Book is a
software program that turns your PC, scanner and sound card into
a full-featured reading machine. Scan a page using a flatbed
scanner, and Open Book will read that page aloud to you. Or,
open and read a text or word-processing file! Open Book lets you
alter the way the page is read aloud to you or, if you have low
vision, modify the way the page is presented on the screen.

Open Book: the Ruby Edition is the latest version of Open Book.
It comes with a host of new features, many of which were
requested by our users. Editing was the biggest request, and we
have added that. You can type in new text, insert bookmarks,
move pages -- it's all possible with the Ruby Edition. Plus, Open
Book comes with a dictionary and thesaurus, spell checker, and
search feature.

If you want to read faster and more easily, Open Book is for you!

Low vision users

Open Book includes many features specially designed for low
vision users:

* Exact View lets you scan and display a page on the screen
exactly as it is in the original document, including graphics,
columns and other elements that affect how the page looks.

* Zoom allows you to change the display of the scanned page
from 25% of normal size to 500% of normal size.

* Color Combinations lets you select text and background color
combinations to make it easier to see the text on the screen.

1
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Visual Settings gives you control over the font type and size,
text, background, and cursor colors, the margin size, and
spacing between characters, word, lines and sentences -- all to
make the page more readable.

How to Use This Manual

This manual will help you understand and operate your new Open
Book reading software quickly and easily.

*

The first chapter, Installing Open Book, helps you install the
software.

The Open Book Tutorial gives an introductory lesson on Open
Book.

Using a Windows Application introduces features specific to
Windows style applications, including menus and dialog boxes.
Using the Keypad describes the unique Open Book Keypad
key assignments, which help you use Open Book quickly and
easily.

Using the Menus details the features available on the menus.
Using the Classic Menus tells you how to use the Ruby
Edition with the menu style used in previous versions of Open
Book.

Using Hotkeys tells you how to use Open Book with the
function keys and keyboard “hotkeys.”

Frequently Asked Questions answers some common
questions.

This manual is available at no charge in Braille. Contact your
dealer or Arkenstone if you would like a copy. If you wish to
create and print your own Braille translations, you can find the
ASCII files MANUAL.TXT and MANUAL.ASC on the Open Book
CD.
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If you have problems with Open Book, please call your
Arkenstone Dealer first. If you do need to contact Arkenstone
Technical Support directly, please note: callers from the United
States and Canada may reach Arkenstone at (800) 444-4443.
Callers from outside the U.S. and Canada should use 1+(650)
603-8880. The Arkenstone FAX number is (650) 603-8887; our
email address for technical support is tech@arkenstone.org.

What You Need to Run Open Book

The minimum system requirements to run Open Book are:

An IBM-compatible Pentium or higher computer

Windows 95, Windows 98, or Windows NT 4.0

32 megabytes of RAM

A CD-ROM drive

85 megabytes of available hard disk space (100 MB or more
recommended)

A standard keyboard

* An SSIL supported speech synthesizer with speaker, or a
SoundBlaster 16-compatible sound card with speaker

* A supported Hewlett-Packard flatbed scanner or a supported
TWAIN-compatible scanner

* K K X ¥

*

Low vision users may prefer to use Open Book with a monitor, or
with a monitor and a speech synthesizer. You can also use a
Microsoft-compatible mouse or other pointing device. We
recommend the following if you are using Open Book with a
monitor:

* A video card and monitor capable of VGA video in 640x480,
256 color mode, or greater
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INSTALLING OPEN BOOK

The Open Book Installation program installs the program and
creates folders for user documents and settings. It also checks to
see if you have a sound card. Finally, the Installation program,
places the Open Book icon on the desktop, and creates an easy-
to-use hotkey to start Open Book.

Before you install:

* Turn on your PC,

* |nstall and turn on your scanner, making sure that it is
unlocked. (Your scanner must be separately installed using the
CD that comes with the scanner.)

* Have your software serial number handy. The serial number is
located in two places: on the outside of the box and on the
outside of the plastic case that holds the Open Book CD.

Note: if you have already installed Open Book, you can skip
this chapter.

Using the talking Windows Installation

Open Book’s Installation program talks, making it easy for you to
hear the prompts. However, if you already have a screen reader,
you may prefer to use that to hear the Installation program. When
you start the Installation program, Open Book runs an audio test
to see if you have a screen reader. If you can hear the test, your
screen reader will operate successfully with our Installation
program. Open Book will then give you the choice of running the
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program with your own screen reader, or using the standard Open
Book talking Installation program.

To navigate through the Installation dialog boxes, you will
generally use the Enter key. The Enter key selects the most likely
option in each section. In addition, you can use the Tab key to
move from element to element. When you cycle through all the
options, you'll return to the first one. To move backwards through
the elements, hold the Shift key, then press the Tab key to cycle
through the options. To hear an entire dialog box read, hold down
the Control key, then press the B key. Once the dialog box
begins speaking you can let go of the B key. To make the
Installation program stop talking, simply press the Control key by
itself.

Once you tab to the selection you want, you have different
options, depending upon whether the element is a button, check
box, or field (see below). However, at any point in the dialog box,
you can press Escape to cancel and close the dialog box, or
Enter to choose an item.

Buttons: Press the Enter key to activate the button, or the Tab
key to move to another element. Dialog boxes usually have three
buttons: Back, Next, and Cancel.

Check Box: Press the Spacebar to check the box; press it again
to uncheck the box. Once you have checked or unchecked the
box, press the Tab key to move to another field or Enter to
advance to the next dialog box.

Edit Fields: Type the appropriate text in the field, then press the
Tab key to move to another field or Enter to advance to the next
dialog box.



INSTALLING OPEN BOOK 7

Starting the Installation program

To begin the installation procedure, place the Open Book CD in
your CD-ROM drive. Open Book automatically starts the
installation process.

If, for some reason, Open Book does not automatically start the
installation process, follow these steps:

1. With the Open Book CD in your CD-ROM drive, open the
Windows START menu on the task bar.

2. Select RUN.

3. In the Edit Field, type in the name of your CD drive (usually
d:\), followed by the word SETUP (for example, d:\setup).

4. Select the OK button in the RUN dialog box, or press the
Enter key.

You can exit the Open Book Installation program at any time,
simply by selecting Cancel.

Once installation begins, follow the prompts to install Open Book.
Open Book will ask whether you want to do a typical or custom
installation.

“Typical” installs the standard files necessary to run Open
Book, Hewlett-Packard scanner drivers, and ViaVoice Outloud
software speech synthesizer, which is included on your Open
Book CD. If you wish to use a different scanner or speech
synthesizer, you must select the Custom installation.

“Custom” gives you more control over where Open Book stores
documents and which files are installed. It also allows you to
install other scanner and speech synthesizer drivers.



8 INSTALLING OPEN BOOK

Unless you need to make detailed modifications, we recommend
that you choose the Typical installation. (For more detailed
information about the installation prompts, see Appendix A:
Detailed Installation, page 115).

If you have any difficulties running Open Book after you have
installed it, check the chapter in this manual titled Frequently
Asked Questions, to see if we address your problem.



THE OPEN BOOK TUTORIAL

This chapter is an introduction to Open Book. If you are new to
computers or to Open Book, this chapter will help you with the
basics. However, if you are an experienced computer user or
have used a previous version of Open Book, you may wish to go
directly to the next chapter, Using a Windows Application.

Please note that this tutorial is not intended as a comprehensive
guide to the features introduced. Once you have completed this
tutorial, you should continue reading this manual to learn more
about each feature in depth. Also note that you must have Open
Book installed before you proceed with this tutorial.

What’s covered in this tutorial

In this chapter, you will learn how to:

start Open Book

use some basic keypad keys

scan and read a page

interrupt scanning

save, name, and close documents
use some basic editing functions
exit Open Book

* ¥ ¥ K X ¥ ¥

About documents and files: throughout this manual, we use the
terms “document” and “file,” sometimes interchangeably. All your
Open Book documents are computer files, but we refer to them as
documents when we are talking about what you have scanned or
what you are reading. However, there are computer files that are
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not documents, such as those that run the Open Book program.
These are always referred to simply as files.

To start Open Book

From a keyboard

During installation, Open Book created a special hotkey to help
you open the program. The hotkey is Control+Alt+O. Hold down
the Control and the Alt keys together while you then press the
letter O. Open Book will say:

“Welcome to Open Book: Ruby Edition. Press the Scan key to
scan.”

Using a mouse

Once you install Open Book, the Open Book icon will appear on
your desktop. If you are using a mouse, simply double click on
the Open Book icon. Open Book will display the welcome screen
and say:

“Welcome to Open Book: Ruby Edition. Press the Scan key to
scan.”

Introducing the Keypad

You can control Open Book in a variety of ways: by using the 17-
key keypad on an enhanced style keyboard, by using the
keyboard itself, or by using a mouse. Many people find the
keypad a quick, easy way to use Open Book.



THE OPEN BOOK TUTORIAL 11

Each of the keypad keys has a name and function assigned to it
in Open Book. You can learn about all of these key assignments
in the chapter titled Using the Keypad. In this tutorial you'll begin
using:

*

The Scan key -- this is the keypad Insert key, the first key on
the bottom row of the keypad. The Scan key starts and stops
scanning. You can also use the Spacebar as the Scan key.

The Speak key -- this is the keypad Enter key, the rectangular
key that sits vertically at the end of the fourth and fifth rows of
the keypad. The Speak key starts and stops reading.

The Select key -- this is the keypad number 5, the key in the
middle of the keypad with the raised dot or bar on it. Select
lets you choose an option. For example, if you are on a menu
item, pressing Select activates that item. Additionally, if you
press this key while reading a page, Open Book will speak the
word the cursor is on. Press it again and Open Book spells the
word. Press it a third time and it spells using military spelling.

The Voice Rate key -- this is the asterisk (the * key). To find
this key, find the top row on the keypad, then find the third key
from the left. This key lets you increase the reading voice rate.
To decrease the voice rate, press the Shift key (usually just
above the far lower left on the keyboard) plus the * key.

The Move keys -- these are the number 2 key (Move Down),
the number 4 key (Move Left), the number 6 key (Move Right),
and the number 8 key (Move Up). To find these keys, place
your middle finger on the Select key, the number 5 key. This
key is in the middle of the keypad with the raised dot or bar on
it. Once positioned on the Select key, the key to your
immediate left is the number 4 key -- Move Left. The key to
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your immediate right is the number 6 key -- Move Right. The
key in the row directly above the 5 key is the number 8 key --
Move Up. The key in the row directly below is the number 2
key -- Move Down.

These movement keys move you up, down, left and right on the
page. For example, if you press Move Up, Open Book moves
to and reads the line above. Press Move Down, and it moves
to and reads the line below. Move Left moves to the previous
word in the line and reads it, while Move Right moves to the
next word in the line and reads it.

Get comfortable with the locations of these keys, because we will
be referring to them throughout this tutorial.

Scanning a page and reading it

Place a page face down on the glass plate of the scanner, making
it square against the raised rims on the right and rear edges of the
glass. Don'’t worry if the page is sideways or upside down -- Open
Book can handle that.

Next, press the Scan key, the keypad Insert key. When you press
the Scan key, Open Book begins scanning the page and opens
the Scan a Page dialog box. If you decide you want to stop
scanning before the page is done, simply press the Scan key
again to cancel scanning.

While Open Book is processing your page, it reports on its
progress. Once the page is scanned and processed, Open Book
will automatically read it aloud to you.
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To stop and start reading

Press the Speak key (the keypad Enter key) to stop reading.
Press it again to start reading. You can also use the arrow keys
to move through the document word by word or line by line.

To change the voice rate

You may find the voice is too slow or too fast. You can change
the speed with the Voice Rate key. Press the Voice Rate key
once. Open Book will say “faster” and increase the reading voice
speed. Keep pressing it until you find the speed you want. If you
want a slower voice rate, press and hold the Shift key (usually just
above the far lower left of the computer keyboard) while you press
the Voice Rate key. Open Book will say “slower” and decrease
the reading voice speed.

To scan and read another page

To read another page, place it on the scanner and press the Scan
key again. Open Book will scan and read the second page.

Open Book will automatically place the second page after the first
page in your document.

To interrupt scanning

If you’re scanning a page and want to stop before scanning is
completed, press the Scan key. Pressing this key while scanning
will interrupt scanning and stop work on the page.
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To save a document

When Open Book first starts, it opens a document on the screen
and names it “Untitled.ark.” If you scan pages into that document,
Open Book automatically saves them under that name. However,
it's much easier to find a document if you give it a name that you
will remember.

To save and name a document, hold down the Alt key, then press
the F key. This brings you to the File menu. Using the Move
Down key, find the menu item called Library. To open the Library
submenu, press the Move Right key.

On the Library sub menu, use the Move Down key to find Save
Document, then press the Select key. Open Book presents you
with a list of categories, including Bill, Books, Mail, Novels and
several others. Using the Move keys, locate a category into which
to save your document, then press Select.

Open Book then asks you to name the document. Type in a
name that you will remember, then press Select.

By the way, if you are saving a document that is already named,
you will still be asked to type in the name. When you do so, and
press Select, Open Book will remind you that there is already a
document by this name, and ask if you want to overwrite it. Use
the Move keys to select Yes if you want to save any changes you
have made to this document. Select No if you want to keep the
older version of the document, and don’t want to save any
changes you made in this reading.
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Opening a document and reading it

In addition to scanning and reading documents, you can also
open and read documents. These can be scanned files or
computer files, such as word processing files.

During installation, Arkenstone installed some sample documents
for you to read. To read one of these documents, go to the
Library. Hold down the Alt key, then press the F key, and then
release them both. Now use the Move Down key to find the
Library menu item. Press the Move Right key to open the Library
sub menu. Choose Read a Document, the first item on this
submenu, by pressing the Select key.

In the list of categories Open Book presents, move to the
category General, then press Select. This category includes four
documents:

Harvest.ark
Story-1.ark
Story-2.ark
Worksheet.ark

Move to one of these documents, and press Select. Once the
document is open, press the Speak key to have Open Book read
it aloud to you. (If you are using a laptop computer, press the F10
or F12 key. These are alternate Speak keys created specifically
for laptop computer users.) Press the Speak key again to stop
reading. Or, use the Move keys to move through the document
word by word.
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To close a document

To close a document that has already been named, once again
use the Library on the File menu. Hold down the Alt key, then
press the F key to get to the File menu. Use the Move Down key
to find the Library. Open the Library submenu by pressing the
Move Right key.

On the Library sub menu, use the Move Down key to find Close
Document, then press the Select key. If you have made changes
but have not yet saved them, Open Book may ask if you want to
save changes you’ve made to the document. Use the Move keys
to choose Yes (save changes), No (don’t save changes), or
Cancel.

Editing

Now you’ve learned how to scan, read, open and close
documents, as well as move around using the Move keys. You're
ready to learn about using Open Book to edit. You can edit and
save a word processing or other computer file. You can also edit
and save a scanned document. Let’s try it with a one of the
sample documents Arkenstone installed with the software.

* First, using the Library, go to the General category and open
Story-1.ark.

% Again using the Library, save that document in the General
category, under a new name: Editing.

Now, open to the Edit Menu. Hold down Alt and press the E key.
Open Book will open the Edit Menu at the item Edit Mode.



THE OPEN BOOK TUTORIAL 17

Right now, you are in Read-only Mode. This means that you can
read the document, but not make edits, protects you from
accidentally making edits to a document. Press Select to activate
Edit Mode and Open Book’s editing capabilities.

A few general notes about editing:
Insert versus Overtype

If you’ve used other PC programs, you know that most programs
start in “insert” mode, that is, if you start typing, the software
inserts what you are typing, but does not “write over” any other
text that may already be on the screen. Some software programs
allow you to switch to “overtype” mode. In this mode, when you
type, you actually write over other text, eliminating it.

Open Book is always in insert mode -- you will never accidentally
type over other text. The only place where your typing may
replace text that’s on the screen is in a dialog box. A dialog box
has buttons and fields that help you perform certain Open Book
features. In some parts of a dialog box, Open Book may offer a
suggestion, for example a name. If you wish to change this
suggested item, simply type a name of your choosing. Your
typing will replace the name Open Book suggested.

Selecting Text

In addition to typing, the other skill you will need to use while
editing is called “highlighting” or “selecting text.” Selecting text
allows you to designate which text will be affected by an editing
operation, for example Copying or Deleting.

To select text using the keyboard, find the word you want at the
beginning of your selection. Next, hold down the Shift key, and
use the Move keys to move through the text until you reach the
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final text you want to select. If you use the Shift key plus the
arrow keys, you will select a character at a time. If you add the
Control key to the Shift and arrow keys, you will select a word at a
time.

To select text using the mouse, place the mouse cursor over the
word you want at the beginning of your selection. Click and hold
down the left mouse button. Drag the mouse through the text,
word by word or line by line, until you reach the final word you
want to select. Let go of the mouse. As you select it, the text on
the screen will be highlighted. Note: don’t use the mouse
anywhere else on the screen or you will deselect the highlighted
text.

The Windows clipboard

When using the edit feature, you will also be using the Windows
clipboard. The clipboard is a special area in the computer that
“holds” text for you. You can cut text, and place it into the
clipboard, then move through the document to find a new location
for the text. Once there, you can paste the text from the clipboard
into the new location.

The clipboard will hold a piece of text in it until you copy new text
to the clipboard, or until you turn off your computer.

To cut and paste text

Select and highlight the first line of text in your document. Now
press Control+X to cut the text. The selected text is removed
from the page and put in the Windows clipboard.
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Using the move keys, find a new location for the text. Press
Control+V to paste the text. The text that you cut to the clipboard
will be inserted at the new location you selected.

To copy and paste text

Select and highlight the another line of text in your document.
Press Control+C to copy the text. The selected text remains on
the page, but is also copied to the Windows clipboard.

Using the move keys, find a new location for the text. Press

Control+V to paste the text. The text will be inserted at the new
location.

To Delete text

Select and highlight a section of text in your document. Now
press the Delete key (it's just to the right of the Enter key on
desktop computers; the location varies on laptops). The selected
text is deleted from the page permanently. When you use Delete,
the text is not copied to the Windows clipboard, it's just gone.

To Find text

Using the Find feature, you can search for a specific word in the
document. It must be a whole word. Here’s how:

* Using the Move keys, move to the top of the page.
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* QOpen the Edit menu and move to the item called Find. Press
Select. Open Book will open the Find dialog box, and say “Find
What?”, then suggest a word to find.

* Type in the word “painless.” Open Book searches for whole
words only and is case insensitive, that is, you can enter the
word with any combination of upper and lower case letters.

* Using the Tab key on the keyboard, tab twice to the Find Next
button, then press Select. Open Book starts searching for the
word you have typed. Ifit finds it, Open Book goes to that word
in the document, and places the cursor at that point. If Open
Book doesn’t find the word, it notifies you.

* When you are done, tab to the Cancel button, then press
Select. This closes the Find dialog box.

To find and replace text

You can also find a word and replace it with another word. This
also must be a whole word.

* Using the Move keys, move to the top of the page.
* QOpen the Edit menu and move to the item called Find, Replace
Text. Press Select. Open Book will open the Find, Replace

Text dialog box, and say “Find What?”, then suggest a word to
find.

* Type in the word “toxic.”

* Tab to the Replace With field. Type the word “poisonous.”
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Tab twice to the Find Next button, then press Select. Open
Book goes to the selected word and places the cursor at that
point.

To replace “toxic” with “poisonous,” tab twice to the Replace
button. Press Select. In the document, Open Book replaces
the word “toxic” with the word “poisonous” and returns you to
the Find Next button, to allow you to search for more instances
of the word “toxic.”

When you are done, tab one time from Find Next to the Close
button, then press Select. This closes the Find, Replace Text

dialog box.

To check your spelling

Open Book’s Spell Check feature will help you check your

spelling. When using Spell Check, Open Book checks all words

against a dictionary, and suggests one or more correct words.

However, Open Book may encounter words that are not in the
dictionary, especially formal names and other proper nouns.
When Open Book encounters a word like this, the word will be

identified as “misspelled.” You can easily ignore these words, and

continue searching for the ones you need to correct. Let's try it
now.

* Using the Move keys, move to the top of the page.

* Next press the F7 key (that’s the seventh function key on the
top row of your computer keyboard).
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Open Book will open the Spell Check dialog box and read the
first item, “Word Not Found?”, then say “Agnes.” The name
Agnes is a proper noun, and is not found in Open Book'’s
dictionary.

If you tab once, you’ll hear that Open Book suggests you
replace “Agnes” with “Agent.” Instead, Tab again to the Ignore
button and press Select. Open Book will ignore this instance of
Agnes and look for the next misspelled word. However, this
will also be “Agnes.”

To avoid being informed about every instance of the
unrecognized word “Agnes,” tab three times, to the Ignore All
button, and press Select. Now, Open Book will ignore “Agnes”
every time it's found.

The next word Open Book will find is Nickerson'’s -- another
proper name. Tab to Ignore.

Now Open Book finds “Grey.” Why is this considered
misspelled? Use the Move Left arrow key to move back
through and listen to this word. You'll hear that it's spelled with
an “e.” This spelling may be correct in some English-speaking
countries, but our dictionary doesn’t accept it. Tab once to
Replace With and you'll see why. Open Book suggests “gray,”
spelled with an “a.” This is the preferred spelling in the United
States.

Tab three times to the Change button, and press Select. Open
Book tells you that it made the replacement. Then it goes on to
find the next misspelled word.

When done, tab until you reach the Close button, then press
Select. This closes the Spell Check dialog box.
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What if | need help?

There are several ways to get help when you are using Open
Book.

Status Bar Help: When you are on a menu, Status Bar Help
messages provide short descriptions of each menu item. They
appear at the bottom of the screen, on the status bar. As you
move through the menu, the status bar updates with a new
message for each item. To hear status bar messages, press
Shift+Control+F10, that is, hold down the Shift and Control keys,
then press the F10 key, located on the very top row of the
keyboard. You can also use Shift+F1 to hear the status bar in a
menu.

Context-sensitive Help: When you are in a dialog box, Context-
sensitive Help provides information about each of the items in the
dialog box. To access Context-sensitive Help, move to the item in
question, then press Shift+F1 (hold the Shift key and press the F1
key, located on the very top row of the keyboard). You can also
access Context-sensitive Help with a mouse with a right click or
by clicking on the ? (question mark) symbol at the top right corner
of the dialog box.

Help Topics: You can read any part of this manual using the
Open Book Help Topics. To access this feature, use the F1 key
(located on the top row of the keyboard). Use the Move keys to
get to Help Topics, then press Select.

Open Book will list all the available Help Topics. Move to the one
you wish to open, and press Select. When you do this, Open
Book opens the selected section of the manual and displays it on
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the screen. You can read this help topic exactly as you would any
other document.

The README: Open Book’s README file gives you the latest
technical information. You can open and read the README file
using Help Topics, which are listed on the Help menu. Access
Help Topics by pressing F1.

Special features for low vision users

This edition of Open Book includes many benefits specially
designed for low vision users. As you learn more about how
Open Book works, pay special attention to the following features:

*

Exact View lets you scan and display a page on the screen
exactly as it is in the original document. This includes any
graphics, line art, tables, columns and other elements that
affect how the page looks. While in Exact View, you can read
the page, change text and background colors, and zoom in and
out, but you cannot edit the text. To make modifications, you
must switch back to Text View. This feature is only available
for scanned pages, not for text or word processing files. Note:
when you open a previously scanned document, it will open in
Text View. You can find this item on the View menu.

Zoom allows you to change the display of the scanned page
shown in Exact View. You can zoom from 25% of normal size
to 500% of normal size. You can find this item on the View
menu.

Color Combinations lets you quickly and easily select text and
background color combinations that may make it easier to see
the text on the screen. Available choices include White Text on
Black Background, Green Text on Black Background, Yellow
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Text on Black Background, and Yellow Text on Blue
Background. You can find this item on the View menu.

* The Visual Settings feature gives you control over the font
type and size, and the text, background, and cursor colors.
You can also use Visual Settings to change the margin size,
and the spacing between characters, words, lines and
sentences, all to make the page more readable. Note that
these changes do not affect the way the text looks while in
Exact View. You must be in Text View to see these changes.
For more information about Exact View and Text View, read the
manual section titled View Menu in Chapter 6: Using the
Menus. The Visual Settings item is on the Settings menu.

To Exit Open Book

When you have finish reading and have closed your document,
you can exit Open Book by holding down the Alt key and pressing
F. Open Book will say “New.” Now you can press the “x” key to
Exit. If you have made changes to your document and not yet
saved those changes, Open Book will ask you if you want to save
them. You can press Y for Yes, N for No, or Escape for Cancel,
or you can use the Tab key to go to the choice you want, then

press Select.

End of Tutorial

Now that you have completed the Open Book tutorial, please
continue with the rest of the manual to learn more about each
feature in depth. The next chapter, Using a Windows
Application, is particularly valuable to both new and experienced
users.
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Remember that you can open and read this manual online, using
the Help Topics in the Help menu.



USING A WINDOWS APPLICATION

Open Book is a Windows application, and many features --
cursor, insertion point, dialog boxes, buttons -- will be familiar to
you if you are a Windows user. If you’re new to Windows, don't
worry! The next two sections will help you learn two ways to work
with Windows features.

In this chapter, we give Windows-style keyboard commands to
perform functions. You can also use the traditional Open Book
keypad commands, including the Select and Escape keys, in
Windows menus. However, the Open Book menu key (the
NumLock key) does not take you in or out of a Windows menu.

When you use Open Book with a speech synthesizer, Windows
features will talk, allowing a user to hear the feature if they cannot
see it. You can learn to use Open Book with a keyboard and
speech synthesizer in the next section, Using Open Book with
keyboard commands.

If you are partially sighted, you may want to use Open Book with a
monitor and mouse. The section titled Using Open Book with a
mouse Wwill help you take advantage of the features available for
low vision users.

Using Open Book with keyboard commands

In this section, you’ll learn how to operate Open Book using
standard Windows keyboard commands.
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Menus

You access Windows menu items by pressing the Alt key. You
can then use the Right and Left arrows to move back and forth
from menu to menu. You can use the Up and Down arrows to
move up and down in the menu, from item to item. Additionally,
you can use the Open Book keypad Move keys (Down, Up, Right,
and Left) to move among and within menus.

You can also access a menu by pressing Alt along with the
assigned shortcut letter in the menu’s name. For example, press
the Alt key plus the S key to get to the Scan menu. This letter is
underlined on the screen. Additionally, any keyboard “hotkeys,”
such as key combinations (Control+O) or function keys (F4)
associated with the menu item are displayed on the menu. In its
default setting, Open Book does not announce these shortcut
keys and hotkeys. You can change this by typing the following
series of commands: Alt+G, G, Alt+K. After you type Alt+K, Open
Book should say “Announce Shortcut Keys: checked.” Now press
Enter. If you ever want to turn this feature back off, follow the
same sequence. Open Book should say “Announce Shortcut
Keys: unchecked” when you press Alt+K this time.

The shortcuts for Open Book’s menus, in order, are:

F for File

E for Edit

S for Scan

V for View

T for Tools

G for Settings
W for Window
H for Help
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When you access an Open Book menu, it presents a drop-down
list of available items. You can move up and down the list by
using the Up and Down arrow keys. Or, you can press the
shortcut key. If, for example, you want to go to the Open item in
the File menu, you can press Alt+F for the File menu, then O for
the Open item.

Finally, for some menu items, you can bypass the menus entirely
by using hotkey combinations, for example Control+O for Open.

Please note that when you first open the software, some menu
items will not be available. If an item is not available, its text will
appear grayed, and Open Book will describe that item as
“inactive.” Once you open or scan a document, additional menu
items become available.

Finally, some menu items have alternate options, for example
Show Exact View and Show Text View. Only one option shows
on the menu at a time.

Dialog Boxes

Many Open Book menu items lead directly to dialog boxes or
property pages, both of which can contain Buttons, Check Boxes,
Edit Fields, Information Fields, and Radio Buttons (only the Print
and Print Setup dialog boxes have Radio Buttons). Use the Tab
key to move from element to element. When you cycle through
all the options, you will return to the first one. To move back to an
element, simply hold the Shift key, and then press the Tab key.
To have Open Book read an entire dialog box, press Control+B.

Once you tab to the selection you want, you have different
options, depending upon the element. At any point on the dialog
box, you can press Escape to cancel and close the dialog box, or
Enter to choose an item.
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Buttons: Press the Enter key to select the button, or the Escape
key to cancel.

Check Box: Press the Spacebar to check this box; press it again
to uncheck the box.

Edit Fields: For blank fields, type the appropriate text in the field.
Sometimes these fields will have suggested text in them. You do
not have to delete the text if you don’t want it. Just type, and your
typing will automatically replace the text in the Edit Field.

Information Fields: You can read these fields, but cannot modify
the information listed.

List Fields: For fields with a list of pre-selected options, use the
Up and Down arrow keys to move through the list, then press the
Enter key to select the item, or the Escape key to Cancel. Or,
type the first letter of the option’s name to move to the correct
item on the list, then press Enter. If there is more than one item
that begins with the letter you typed, Open Book will move to the
first word that begins with the letter. You can then use the arrow
keys to move to the correct item.

Radio Buttons: These come in pairs or groups. You must select
one and only one of the options. Use the up and down arrows to
move among the available options. Each time you move to a new
option, you automatically select that option, and the others are
deselected. Once you have moved to the option that you want to
select, you can tab to the next item.

To select text: To use certain Open Book menu features -- such
as Copy or Delete -- you need to first select (or “highlight”) the text
you wish the feature to act upon. Once the cursor is on the first
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word you wish to select, hold down the Shift key, then press the
Right arrow. Open Book will move through the text, highlighting it.

Other ways to operate Open Book

You can also operate Open Book using keypad, function, and
shortcut keys. For more information, see the chapter titled Using
Hotkeys. Additionally, you can continue using the traditional
Open Book Library feature while in the Windows Menus. The
Library is an excellent tool for organizing your documents. |t
contains built-in categories for your most common document
types. You can also add categories if you want. You can open,
close, and save documents, or convert them to word processing,
ASCII, or spreadsheet file formats. The Library is located on the
File menu. By the way, if you convert your old Open Book library
for use with Open Book: Ruby Edition, you will find those
documents in the Library.

Using Open Book with a mouse

Another way to operate Open Book is with a mouse.
Menus

If you are a mouse user, you can access the menus by clicking
directly on the menu bar headings, located at the top of the
screen. The menu then opens a drop-down list of available items.
If a menu item is grayed, that means it is not currently available.
Some menu items will not be available until you open or scan a
document. Note that some menu items have alternate options,
such as Edit Mode and Read-only Mode. Only one option shows
on the menu at a time.
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Dialog Boxes

Many Open Book menu items lead to dialog boxes. You can click
directly on any option in the box to select it. Sometimes you will
then need to click on the OK button. You can also double click on
the button -- in some cases this will activate the button and close
the dialog box. At any point on the dialog box, you can click on
the Close or Cancel button, or on the small box with an X in it at
the top right corner of the dialog box.

Buttons: Click to select the button.

Check Box: Click to check this box; click again to uncheck the
box.

Edit Fields: Click on the field, then type the appropriate text.

List Fields: For fields with a list of pre-selected options (List
Fields), click on either the field or the arrow to the right of the field,
to reveal the list. Then click on the desired item.

Radio Buttons: These come in pairs or groups. You must select
one and only one of the options. Click to select the desired
option. Each time you click on a new option, you automatically
select that option and the others are deselected.

To select text: To use certain Open Book menu features -- such
as Copy or Delete -- you need to first select (or “highlight”) the text
you wish the feature to act upon. Once the cursor is on the first
word you wish to select, use the mouse to select the text.
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Open Book was originally designed to be used primarily with the
17-key numeric keypad, with some functions duplicated on the
rest of the keyboard for laptop computers. If you have used
previous versions of Open Book, you may feel more comfortable
using the keypad.

The typical keypad is usually laid out, from left to right, like this:

* The top row: the Num Lock key, the Forward Slash key, the
Asterisk key, and the Minus key.

* The second row from the top: Home (#7), Up Arrow (#8), Page
Up (#9), and the top half of the Plus key.

* The third row from the top: Left Arrow (#4), #5 (with tactile
underbar or dot), Right Arrow (#6), and the bottom half of the
Plus key.

% The fourth row from the top: End (#1), Down Arrow (#2), Page
Down (#3), and the top half of the Enter key.

* The bottom row, fifth row from the top: the Ins key (#0), the
Delete Key (Decimal point), and the bottom half of the Enter
key.

Each of these keys has a name and function assigned to it in
Open Book. The Open Book keys are, from left to right:

The top row:
The Num Lock key is the Menu key. This key activates the
Classic-style Open Book menus that allow you to choose different

options and change Open Book’s settings. The Menu key is a
toggle key: press it to get into the menu, and press it again to
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leave the menu. Note: this key will not access the Windows
menus.

Forward Slash key (/) is the Scanning Status key. This key
indicates the page progress information for a page that is
currently being scanned. If you are not scanning, it indicates that
no page is being scanned. This key is also a toggle key.

The Asterisk key (*) is the Voice Rate key. This key allows you
to change the speed of the voice while reading a document. Press
Voice Rate key to read faster, or the Shift key (usually just above
the far lower left on the keyboard) to read slower. Open Book will
say “faster” or “slower.”

The Minus key (-) is the Help key. This key will present you with
Open Book’s list of Help Topics, to allow you to read the manual
on-line. This key is also a toggle key.

The second row from the top:

The Home key (7) is the Where Am |? Key. This key explains
where you are in the reading process or in the menus. Press it
while in a menu, and it will tell you what menu you are in. Press it
while in a document, and it will list the line and page number you
are on.

The Up Arrow key (8) is the Move Up key. This key moves you
up one line if you are reading a page, or up one choice if you are
in @ menu.

The Page Up key (9) is the Page Up key. This key moves to the
previous page in the document (if there is one). If you are in a
List Field on a menu, it moves you to the previous group of items
in the list.
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The Plus (+) is the Escape key. This key exits the current
activity or allows you to leave a menu or Help when you are
finished with it. Note: if you are scanning a page, Escape will not
stop the scanning process. To interrupt scanning, use the Scan
key.

The third row from the top:

The Left Arrow key (4) is the Move Left key. This key moves
you back a word while you are reading. (Note: if you have
changed the Movement Unit, Move Left may move you back a
letter, a sentence, a line, or a paragraph.) To go a long way back,
hold the Move Left key down, and you will quickly move backward
through the page. Open Book will not speak the text as you skim
through it, but once you stop, it will say the word the cursor is on.
To begin reading again, press the Speak key.

The Center Key (5) is the Select key. This key selects the
current choice in a menu or in a dialog box. If you are reading,
press this key once and Open Book speaks the word the cursor is
on. Press it again and Open Book spells the word aloud. Press it
a third time to spell the word with the military alphabet, using
words like Alpha, Bravo, and Charlie for the letters A, B and C.
The Select key’s spelling functionality also works when you are in
a dialog box, to read and spell information in fields and button
names.

The Right Arrow key (6) is the Move Right key. This key
moves you forward a word while you are reading. (Note: if you
have changed the Movement Unit, Move Left may move you
forward a letter, a sentence, a line, or a paragraph.) To go a long
way forward, hold the Move Right key down, and you will quickly
move through the page. Open Book will not speak the text as you
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skim through it, but once you stop, it will say the word the cursor
is on. To begin reading again, press the Speak key.

The fourth row from the top:

The End key (1) is the Key Describer. This key describes the
function of the other keys. Press this key and the other keys
become inactive; then press any key and Open Book will
announce the key’s name or function. Press the Key Describer
again to return the keypad to its normal function.

The Down Arrow key (2) is the Move Down key. This key
moves you down one line if you are reading a page, or down one
choice if you are in a menu.

The Page Down key (3) is the Page Down key. This key moves
to the next page in the document (if there is one). If you are in a
List Field on a menu, it moves you to the next group of items in
the list.

The Enter key is the Speak key. This key starts and stops
reading, interrupts speech, or repeats the current item in a menu
or dialog box. The Speak key also works when you are in a
dialog box, to announce button names or information in fields.

The bottom row (fifth row from the top):

The Insert key (0) is the Scan key. This key starts or stops
scanning.

The Delete key (.) is the Delete key. This key deletes the
current page you are reading, or deletes a character when you
are typing an entry, such as a file name.
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Please note a few of the conventions used in this manual:

* When introducing menu items, their hotkey combinations are
indicated in brackets.

* \When describing dialog boxes or property pages, each element
in the box will be described in the order you encounter it when
tabbing through the box. The element will be described by
name (such as Close) and by element type (such as Button).

% |Important notes are listed in italic text; warnings are listed in
bold text.

To start Open Book

From the Windows desktop, you can use the Open Book hotkey,
Control+Alt+O, or you can use a mouse to double click on the
Open Book icon.

File Menu

This menu allows you to open, save, print documents, or quit
Open Book.

New [Control+N]: Select this menu item to create a new
document. When you select New, Open Book opens a document
and names it “Untitled.” You can scan pages into this document,
and save it under a new name. You can also open a new
document using the Create a New Document option, located on
the Library submenu (see below).
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Open [Control+0]: Select this menu item to open a document.
When you select Open, Open Book opens a dialog box called
Select a File to Open. The dialog box contains a list of available
documents. Use the Tab key to move from field to field, and the
Up and Down arrows to move from item to item within a field.
Once you open a file, you must press the Speak key to have
Open Book begin reading to you. Open Book is capable of
opening most files, including Microsoft Word, Word Perfect,
ASCII, Text, HTML, and RTF files, as well as documents you
have previously scanned and saved. You can also open a
document using the Read a Document or Read a File menu
items, located on the Library submenu (see below).

File Name edit field: type the name of the document.

File list field: to move up and down the list of available
documents, type the first letter or letters of the document name
or use the arrow keys. Press Enter to select the file you want
to open. If the folder is empty, Open Book will say “No entries.”
Note that when you first Tab to this field, Ruby will say “No
selection” because Windows does not let you select the file
until you have used the arrow keys in the file list.

Folders list field: to move among directory choices, use the
arrow keys, then press the Enter key when you find the folder
you want to open. The file list (see above) will now contain the
files in that folder. Some folders contain other folders, so you
may need to move through more than one layer before you find
the file you want.

List Files of Type list field: to move among the choices, type
the name of the file format or use the arrow keys.

Drives list field: to move among the drive choices, use the
arrow keys, then press the Enter key when you find the drive
you want to open. The Folders list (see above) will now contain
the folders in that drive.
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OK button: opens the selected document.
Cancel button: closes the dialog box without opening a new
document.

A note about opening files: if you create files using a word
processing program or other application, those files will be saved
in the appropriate location for that application. This will probably
not be the same place that your Open Book documents are
stored. Use the Folders field to go to the folder that contains your
other documents. After you open a file, you can save it to your
Open Book Library or any other location.

Close [Control+W]: Select this menu item to close the document
you are currently reading. If you have made changes to the
document, Open Book will prompt you to save the document.
Some changes can only be saved in Open Book’s special format,
which uses an .ark extension. When you select Close, Open
Book will alert you to this, also, and give you the option to keep
the Open Book-specific changes, saving them in Open Book’s
.ark format, ignore those changes and save the document in
another format, or Cancel. If you do not have a document open,
this item will not be available. You can also close a document
using the Close Document option, located on the Library
submenu (see below).

Save [Control+S]: Select this menu item to save the document
you are currently reading without closing it. When you select
Save, Open Book automatically saves the document, and you can
continue reading. Some changes can only be saved in Open
Book’s special format. When you select Save, Open Book will
alert you to this and give you the option to keep the Open Book-
specific changes in Open Book’s .ark format, ignore those
changes and save the document in another format, or Cancel.
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You can also save a document using the Save Document option,
located on the Library submenu (see below).

Save As: Select this menu item to save a copy of this document
under a new name or a different file format. The .ark file format
saves all changes that you have made to the document in Open
Book, including text edits and bookmarks. The .txt format saves
only the actual text -- bookmarks will be omitted. Other formats
include Word, WordPro, WordPerfect, and HTML. You can also
save and name a document using the Save Document option,
located on the Library submenu (see below).

File Name Edit field: type the name of the document, or use
the name Open Book suggests.

File list field: this is a list of all files in the current folder. You
can use the arrow keys to move up and down the list, or you
can type a letter and Open Book will take you to the first file
that begins with that letter. Press Enter to select a file. If the
folder is empty, Open Book will say “No entries.” If you choose
an existing file name, Open Book will replace that document file
with your new one, but it will warn you first. Note that when you
first Tab to this field, Ruby will say “No selection” because
Windows does not let you select the file until you have used the
arrow keys in the file list.

Folders list field: to move among directory choices, use the
arrow keys.

List Files of Type list field: to move among the choices, type
the name of the type of document or use the arrow keys.
Drives list field: to move among the drive choices, use the
arrow keys.

OK button: saves the document under the selected name.
Cancel button: closes the dialog box without saving the
document.
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Library: Select this menu item to use Open Book’s Library
feature. Previous users of Open Book will be familiar with the
Library, which allows users a different way to manage documents.
Instead of the Windows structure of files stored in directories, the
Library calls the files Documents, and stores them in Categories.
If you convert old Open Book documents for use with Open Book:
Ruby Edition, you can access those documents using the Library
feature. Finally, the Library also gives you two additional menu
functions: Delete and Convert.

When you select Library, Open Book opens a submenu of library
options:

Read a Document: this option allows you to open a document
for reading. When you select Read A Document, Open Book
presents you with a list of categories. Select the category, and
Open Book lists the documents in that category, or notifies you
if there are no documents in that category. You can also use
Open in the File menu to open Library documents.

Create a New Document: this option allows you to create a
new document, save it to a library category, then scan pages
into it. When you select Create a Document, Open Book
presents you with a list of categories first. Once you choose
your category, Open Book allows you to name the document.
You can also use New in the File menu to open a new
document..

Close Document: this option allows you to close the document
you are currently reading. When you select Close Document,
Open Book alerts you if you need to save the document first, or
if changes you have made cannot be saved in Open Book’s
.ark format. If you do not have a document open, this item will
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not be available. You can also use Close in the File menu to
close a document.

Save Document: this option allows you to save the document
you are currently reading. When you select Save Document,
Open Book presents you with a list of categories first. Once
you choose your category, Open Book allows you to name the
document. If you do not have a document open, this item will
not be available. You can also use Save or Save As in the File
menu to save a document.

Convert Document: This option allows you to convert an Open
Book document to a word processing, ASCII, spreadsheet, or
HTML format. When you select Convert, Open Book brings up
the Save As dialog box. Choose the file format in the Save
Files of Type field. Then give your document a name. You can
also use the List Files of Type item in the File Save As dialog
box to convert a file to a different format.

Delete a Document: this option allows you to delete a
document. When you select Delete Document, Open Book
presents you with a list of categories. Select the category, and
locate the document within the category. Open Book will ask
you to verify your deletion.

Create a New Category: this option allows you to create and
name new categories. Be creative!

Delete a Category: this option allows you to remove categories
that are obsolete. However, you will not be able to delete a
category until you have deleted all documents inside that
category. Open Book will ask you to verify your deletion.
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Read a File: this option allows you to read a word processing,
ASCII, or spreadsheet file. Once you select Read a File, you
enter the standard Windows Select a File dialog box with a list
of available documents. Proceed as you would for the Open
feature (see above). You can also use Open in the File menu to
open a file.

Print [Control+P]: Select this menu item to print the document.
When you select Print, Open Book opens the standard Windows
Print dialog box. The printed copy of your document will reflect
the text size, font and spacing choices you have selected. If you
are using a color printer, your colored text will print in color. If you
do not have a document open to print, this item will not be
available.

Name edit field: indicates the printer currently selected. To
select a different printer, type in the name or use the arrow
keys.

Status information field: indicates the status of your printer,
such as ready or busy.

Type information field: tells what kind of printer you have.
Where information field: indicates the location of your printer
and the printer port it is using.

Comment information field: includes any additional
information about the printer.

All Pages radio button: prints the entire file. Use the arrow
keys to move from this to the options listed below it.

Pages radio button: allows you to select a range of pages.
Use arrow key to select this option, then use the Tab key to
move to the From and To entry fields. Enter the first page you
want to print in the From entry field. Enter the last page you
want in the To field.
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Selected Text Only radio button: when this option is selected,
Open Book prints only the text you have previously selected in
the document.

All Pages Plus Bookmarks radio button: prints the entire
document, then prints the word associated with each numbered
bookmark in your document.

Number of Copies edit field: enter the number of copies to
print by typing or using the arrow keys.

OK button: sends the print job to the printer and closes the
dialog box.

Cancel button: closes the dialog box without printing.

Print Setup: Select this menu item to determine how Open Book
sets up the document for printing: the size of the page, print
margins, direction on the page, and how it feeds out of the printer.
When you select Print Setup, Open Book opens the standard
Windows Setup dialog box. At the top of the Setup dialog box is a
picture of your document. As you make changes, this picture
demonstrates those changes. If you do not have a document
open, this item will not be available.

Paper Size list field: indicates the size of paper currently
selected. To select a different size, use the arrow keys.
Paper Source edit field: indicates the current printer tray or
feeder. To select a printer tray or feeder, type in the name or
use the arrow keys.

Portrait radio button: use arrow keys to move between this
and the Landscape option.

Landscape radio button: use arrow keys to move between
this and the Portrait option

Left Margin edit field: to change the left margin, type in a
number or use the arrow keys. This margin overrides any side
margins you may have set while viewing your document in
Open Book.
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Right Margin edit field: to change the right margin, type in a
number or use the arrow keys. This margin overrides any side
margins you may have set while viewing your document in
Open Book.

Top Margin edit field: to change the top margin, type in a
number or use the arrow keys.

Bottom Margin edit field: to change the bottom margin, type
in @ number or use the arrow keys.

OK button: saves the printing settings and closes the dialog
box.

Cancel button: closes the dialog box without saving the
printing settings.

Document Properties [Control+R]: Select this item to learn
specific information about the open document. When you select
Document Properties, Open Book opens a dialog box listing
various facts about the document. Use the Tab key to move
through the page, or use Control+B to read the whole dialog box.

Document Name field: This is the first of eight fields,
including: Document name, Document type, MS-DOS name,
Document location, Document size, Date created, Last
modified, and Last accessed. These fields do not allow you to
modify or add information.

Close button: closes the Properties dialog box.

List of recently read files (numbered 1 through 5): Select this
menu item to open the indicated document. This convenient
Windows feature allows you to easily open the files you last used.
When you select the number of the document, Open Book opens
that file.

Exit: Select this menu item to close Open Book. When you select
Exit, Open Book closes the current document or documents, then
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closes Open Book and returns to the Windows desktop. If you
have made changes to any open documents, Open Book will ask
if you want to save the changes.

Edit Menu

This menu allows you to edit a document, find text, add a
bookmark, jump to a specific page, or move pages around in your
document. Using the edit feature, you can type new text into a
document; move, copy or delete text; introduce or delete page
breaks; and move pages of text around within the document.

Edit Mode/Read-only Mode [Control+E]: Select this menu item
to switch between Edit Mode and Read-only Mode. When you
start Open Book, you are in Read-only Mode. To switch to Edit
Mode, move to the item on the menu, then press Enter. Or,
select the item by using the menu shortcut key. Once you check
the item, Open Book will tell you whether you are in Edit Mode or
Read-only Mode.

Undo [Control+Z]: Select this menu item to undo the last edit
you performed, whether it was typing or deleting. Note that Undo
only undoes the last change you have made. This item is only
available when you are in Edit Mode and have edited a document.

Cut [Control+X]: Select this menu item to remove selected text
from the document and copy it to the Microsoft Windows
clipboard. You can only use this item if you have already selected
text using the Shift key with the arrow keys, or if you have used a
mouse to drag-select some text. Once you have selected the
text, select Cut, and Open Book deletes the text from the
document and copies it to the clipboard. You can then paste the
text into another part of the open document, into a new Open
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Book document, or into another application such as Microsoft
Word. This item is only available when you are in Edit Mode and
text is selected..

Copy [Control+C]: Select this menu item to copy selected text to
the Microsoft Windows clipboard without removing it from the
document. You can only use this item if you have already
selected text using the arrow keys or mouse. Once you have
selected the text, select Copy, and Open Book copies the text to
the clipboard. You can then paste the text into another part of the
open document, into a new Open Book document, or into another
application such as Microsoft Word.

Paste [Control+V]: Select this menu item to insert text from the
Microsoft Windows clipboard into your document. You can only
use this item if you have already copied selected text into the
Clipboard. You can paste the text into another part of the open
document or into a new Open Book document. (Or you can paste
text into another application such as Microsoft Word, by using the
hotkeys or using that application’s Paste function.) Find the
location where you want the text inserted, then select Paste. The
text is inserted into the document. This item is only available
when you are in Edit Mode and there is already text in the
Clipboard.

Delete [Del]: Select this menu item to delete selected text from
the document without copying it to the Microsoft Windows
clipboard. Once you have selected the text, select Delete, and
Open Book deletes the text from the document. This item is only
available when you are in Edit Mode.

Select All [Control+A]: Select this menu item to select (or
“highlight”) all the text in the document. Once you have selected
all the text, you can Cut, Copy, or Delete it. Although this item is
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available in both Read-only and Edit Mode, you can only Cut,
Delete, and Paste the selected text when you are in Edit Mode.

Find [Control+F]: Select this menu item to find a word or phrase
within the open document. When you select Find, Open Book
opens the Find dialog box.

Find What edit field: type in the text you wish to find. Open
Book searches for whole words only and is case insensitive --
you can enter the word with any combination of upper and
lower case letters, and it will find each occurrence of that word.
Search Direction list field: to move between Up and Down,
type “U” or “D” or the press the arrow keys. Select Down if you
wish to search forward from your current point in the file. When
it reaches the end of the file, the Find feature will wrap around
to the beginning of the file and search from there to your
cursor. Select Up if you wish to search back from your current
point in the file toward the beginning of the file. When it
reaches the top, it will search from the end to your cursor.
Either way, it will search the entire document.

Find Next button: starts searching for the next occurrence of
the word or phrase you have typed. If it finds the text you are
seeking, Open Book goes to that text in the document, and
places the cursor at that point. |f Open Book does not find the
text you are seeking, it notifies you.

Close button: closes the dialog box.

Find, Replace Text [Control+H]: Select this menu item to find a
word or phrase within the open document, and replace it with
alternative text. When you select Replace, Open Book opens the
Find and Replace dialog box.

Find edit field: type in the text you wish to find. Open Book
search for whole words only and is case insensitive -- you can
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enter the word with any combination of upper and lower case
letters, and it will find each occurrence of that text string.
Replace edit field: type in the word you want to use as
replacement text, or paste it from the Clipboard.

Search Direction list field: to move between Up and Down,
type “U” or “D” or the arrow keys. Down is the default direction.
It searches from your current point in the file to the end, then
starts at the beginning of the file and searches to your current
position. The Up direction begins at your current point in the
file, searches back to the beginning, then starts at the end of
the file and searches back to your current position.

Find Next button: starts searching for the next occurrence of
the word or phrase you have typed. If it finds the text you are
seeking, Open Book goes to that text in the document, and
places the cursor at that point. If Open Book does not find the
text you are seeking, it notifies you.

Close button: closes the dialog box.

Replace button: substitutes the replacement text for the Find
text in the current instance only. This item is only available
when you are in Edit Mode.

Replace All button: searches through the entire document,
and automatically substitutes the replacement text for the
“Find” text in all instances. This item is only available when you
are in Edit Mode.

Go To Page [Control+G]: Select this menu item to go to a
specific page in the open document. When you select Go To,
Open Book opens the Go To Page dialog box.
Enter the Page Number edit field: type in the number of the
page you wish to go to.
OK button: takes you to the top of the page whose number
you have specified.
Cancel button: closes the dialog box without moving your
cursor.
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If the document does not contain the requested page, Open Book
will take you to the nearest page, which will be the first or last
page in the document.

Insert Bookmark [Control+F9]: Select this menu item to insert a
bookmark symbol in the document text. Each bookmark is
numbered and is linked to the word to its right. You can use
bookmarks as placeholders. You can jump from bookmark to
bookmark. You can also print your file including bookmarks.
When you select Insert Bookmark, Open Book inserts a
numbered bookmark at the current cursor position in the open
document. You can insert as many bookmarks as you want in
each document.

Delete Bookmark [Shift+Control+F9]: Select this menu item to
delete a selected bookmark symbol in the document text. You
can only use this item if you have already selected text using the
arrow keys or mouse. Once you have selected the text, select
Delete Bookmark, and Open Book deletes the bookmark from the
document. You can also delete a bookmark by placing your
cursor immediately after the bookmark character and pressing the
Backspace key.

Go To Bookmark [F9]: Select this menu item to jump to a
bookmarked word in the open document. When you select Go To
Bookmark, Open Book opens the Go To Bookmark dialog box. If
the open document does not contain bookmarks, this item will not
be available.

Enter a Bookmark Number edit field: type in the number of
the bookmark you wish to find.

Next Bookmark button: takes you to the next bookmark in the
document.
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Previous Bookmark button: takes you to the previous
bookmark in the document.

First Bookmark button: takes you to the first bookmark in the
document.

Last Bookmark button: takes you to the last bookmark in the
document.

Go button: takes you to the bookmark whose number you
have typed into the Edit Field.

Close button: button closes the dialog box.

If the document does not contain the requested bookmark, Open
Book will beep and the cursor will remain where it is.

Insert Page Break [Control+Enter]: Select this menu item to
insert a page break in the document. If you select Insert Page
Break while you are reading a scanned file, Open Book warns you
that you will lose any images associated with the pages. This
means that your Text View (the one you are editing) will no longer
match your Exact View. Open Book then inserts a page break
immediately before the current line of the document. The text
after the inserted page break becomes the beginning of the new
page; the text before the inserted page break becomes the end of
the previous page. This item is only available when you are in Edit
Mode and are working with a scanned document.

Delete Page Break [Shift+Control+Enter]: Select this menu
item to delete a page break in a document. You can only use this
item if you have already placed your cursor immediately before
the page break, that is, when you cursor is on the last line of the
previous page. When you select Delete Page Break, Open Book
deletes the break from the document, merging the second page
into the first. This item is only available when you are in Edit
Mode.
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Move Page: Select this menu item to move the current page to
another location in a document. When you select Move Page,
Open Book opens the Move Page dialog box. If the open
document does not contain more than one page, this item is not
available.

Move Up One Page button: moves the current page forward
one page in the document.

Move Down One Page button: moves the current page back
one page in the document.

Move to Top button: moves the current page to the beginning
of the document.

Move to Bottom button: moves the current page to the end of
the document.

Move to Page edit field: type in the page number to which you
wish to move the current page. Or type in the relative position
you want to move to. For example, if you are on page 50 and
you know you want to move the page to page 48, you can enter
—2 to move back 2 pages. Or enter +10 to move the page
forward 10 pages in the document.

OK button: moves the current page to the page number you
have typed into the Edit Field.

Cancel button: closes the Move Page dialog box.

Once Open Book moves the page, it will tell you the current
page’s new page number. Please note that all other pages in the
document will be renumbered as necessary to accommodate the
moved page.

Delete Current Page [Control+Delete]: Select this menu item to
delete the page your cursor is on. When you select Delete
Current Page, Open Book opens a small dialog box on the screen
warning you that page deletion cannot be undone, and asking you
to confirm the deletion.
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OK button: deletes the page and closes the Delete dialog box.
Cancel button: closes the Delete dialog box without deleting
the page.

Scan Menu

This menu lets you control how Open Book scans, and displays
the page after scanning it. If you do not have a scanner installed,
items on this menu may not be available.

Scan a Page [Ins, Spacebar, or F4]: Select this menu item to
begin scanning the page you have placed on the scanner. The
Spacebar and the Insert key on the numeric keypad can also be
used as Scan keys.

Scan a Page is actually three processes:

* scanning the page -- taking a picture of each page;

* preparing the page -- cleaning up the picture to get the best
possible image;

% recognizing the page -- translating the page into readable text.

Open Book provides a number of ways to scan and read text, all
of which can be set using the Scanning Settings, located on the
Settings menu. To learn more about Open Book’s scanning
options, see the section of this manual describing Scanning
Settings (page 69).

During the scanning process, Open Book will give you progress
reports and prompt you for action using the Scan a Page dialog
box. This box includes the following items
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Scanning Image field: tells you when this stage of the
scanning process is complete.

Preparing Image field: tells you when this stage of the
scanning process starts.

Recognizing Text field: tells you when this stage of the
scanning process starts.

Button: Cancel stops scanning and closes the dialog box.

Place the page to be scanned on the scanner first, then begin
scanning. While the page is being scanned, a dialog box informs
you that Open Book is processing the page. If you cancel
scanning, there may be a slight delay before Open Book
interrupts the scanning process. When you scan subsequent
pages, Open Book inserts them at the end of your document (no
matter where your cursor is).

Scan and Replace Current Page: Select this menu item when
you are in a scanned document, to scan a page and have it
replace the current scanned page. This function is useful if you
are reading a document and come to a page that seems to
contain nonsense words or symbols, indicating that the first scan
may have had errors or the page may have been skewed. Scan
and Replace Current Page lets you re-scan that page and put it in
the right place in your document. Note: when you are doing 2-
page Scan and Replace, this replaces both facing pages of the 2-
page book: the current and the next page.

Scan and Insert New Page: Select this menu item when you are
in a document, to scan a page and have it inserted before the
current scanned page. You can insert a new scanned page in
any document, including a word processing file. This tool lets you
insert pages at any location in the document. Note: when you
are doing 2-page Scan and Insert, this inserts two new pages in
your document: both facing pages of the 2-page book.
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Buckscan [Control+M]: Select this menu item to scan currency
and learn the denomination. Place the bill horizontally on the
glass plate of the scanner, making it square against the raised
rims on the right and rear edges of the glass. If you have an HP
flatbed scanner, make sure the long side of the bill is against the
top edge of the glass plate. If you have a TWAIN scanner, make
sure the long side of the bill is against the front and left edges.
Press Control+M or select Buckscan from the Scan menu. Open
Book will scan the bill and tell you the denomination.

Recognize Columns: Select this item to determine how Open
Book will handle reading a page with columns. This menu item is
checked by default. To check or uncheck this item, move to the
item on the menu, then press the Spacebar. When checked,
Open Book will read down columns of text (like in a newspaper).
When this item is not checked, Open Book will read across
columns of text (like in a table). Use Recognize Columns to read
a standard (single column) page, or to read multi-column pages.

Color Scanning: Select this menu item to scan pages of colored
text, art and photographs in color; black and white text, art and
photographs will continue to be scanned in black and white. When
you start Open Book, this selection is not checked. To check or
uncheck this menu item, move to the item on the menu, then
press Enter. If you do not have a color scanner installed, Open
Book will tell you that color scanning is not possible, and continue
scanning in black and white. Color scanning takes significantly
longer, so use color scanning only when you have sufficient time
to process the scans.

2-Page Scanning: Select this menu item to scan two side-by-side
pages of an open paperback book or other book whose facing
pages can both fit on the scanner glass. Open Book will store the
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pages separately, with separate page numbers. This allows the
page numbers in your document to match the page numbers in
the scanned book. After scanning, Open Book will automatically
read the first page first, then read the second page. When you
start Open Book, this selection is not checked. To check or
uncheck this menu item, move to the item on the menu, then
press Enter. If you do not have a scanner installed, this menu
item is not available.

The following two scanning features are alternate options.
You can select only one of the options, and when you do, the
other is automatically de-selected. To check an item, move to
it on the menu, then press Enter.

Scan for Accuracy: This menu item is checked by default on
startup. When checked, Open Book scans the document using
the highest degree of scanning accuracy, along with other special
scanning features. However, accurate scanning does take
longer.

Scan for Speed: This menu item is not checked on startup.

When checked, Open Book scans the document faster, but some
degree of accuracy may be lost.

View Menu

This menu allows you to choose which Open Book screen
elements are visible, in which format pages are displayed, and
determine the scrolling and zoom options. Note: items in this
menu are designed to be used with a monitor.

Show Exact View/Show Text View: Select Show Exact View to
display the scanned page on the screen just as it is in the original
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document, including any graphics, line art, tables, columns and
other elements that affect how the page looks. While in Exact
View, you can read the page, change text and background colors,
zoom in and out, and use the dictionary and spelling functions.
However, you cannot edit or make any other modifications to the
way Open Book presents the text. To make modifications, you
must switch to Text View. You cannot select Exact View if you
are reading a text, word processing or other electronic document:
this item is only available for scanned pages. Note: when you
open a previously scanned document, it will automatically open in
Text View. Change to Exact View using this menu item.

Select Show Text View to display only the text from the page,
without graphics, line art, tables, columns and other elements that
affect how the page looks. While in Text View, you can edit the
document and modify the way Open Book presents text on the
screen. When opening a document, Open Book automatically
selects this View. The Exact View is only available if you have
selected “Save Exact View” in the Scanning Settings page of the
Sefttings menu.

The following five items are alternate options. You can select
only one of the options, and when you do, the others are
automatically de-selected. To check an item, move to it on the
menu, then press Enter.

Black Text on White Background: Select this menu item to

display black text on a white background.

White Text on Black Background: Select this menu item to

display white text on a black background.

Green Text on Black Background: Select this menu item to
display green text on a black background.

Yellow Text on Black Background: Select this menu item to
display yellow text on a black background.
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Yellow Text on Blue Background: Select this menu item to
display yellow text on a blue background.

Status Bar [Control+F6]: Select this menu item to display or hide
the status bar (the line at the bottom of the screen). To check or
uncheck this menu item, move to the item on the menu, then
press Enter. Or, select the item by using the menu shortcut key.
When the cursor is on a menu item, the status bar displays a brief
description of that item. To have that information spoken, press
Shift+F1.

Zoom Page: Select this menu item to open a submenu that
allows you to change the display of the scanned page shown in
Exact View. The second menu is a list of zoom ranges from 25%
of normal size to 500% of normal size. To check or uncheck a
zoom range, move to the number on the menu, then press Enter.
Or, select the item by using the menu shortcut key. This item is
only available if you are viewing a page using Exact View.

Page Scrolling: Select this menu item to open a submenu that
allows you to determine how much of the page is moved up when
Open Book is reading and gets to the bottom of the page:

* One line -- Open Book scrolls up one line at a time.
* 1/2 screen -- Open Book scrolls up half a screen.
% 3/4 screen -- Open Book scrolls up nearly a full screen.

To check or uncheck a scrolling option, move to the item on the

menu, then press Enter. Or, select the item by using the menu
shortcut key.

Tools Menu
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This menu gives you access to a variety of tools including a spell
checker and reference materials.

Spell Check [Control+K, F7]: Select this item to open the spell
checker. You can check the spelling of a specific word, or of all
the words in the document. Open Book checks words against a
standard dictionary and against your “personal dictionary,” a list of
words that you can enter.

When you select Spelling, Open Book opens the Spelling dialog
box. The first word identified by the dictionary as misspelled is
spoken when the dialog box opens

Word Not Found edit field: indicates the word that has been
identified as misspelled or unknown.

Replace with list field: a list of possible replacement words.
Use the arrow keys to move up and down among the choices.
Ignore button: leaves the word in the Word Not Found field
unchanged.

Ignore All button: leaves all occurrences of the word in the
Word Not Found field unchanged.

Change button: accepts the change suggested in the Replace
field for this specific occurrence of the word.

Change All button: changes all occurrences of the misspelled
word to the word suggested in the Replace field.

Add to Dictionary button: adds the word to your own list of
frequently-used words not found in the standard dictionary.
Close button: closes the Spelling dialog box.

Spell Word [Control+L, Control+F3]: Select this menu item to
spell the word the cursor is on. When you select Spell, Open
Book speaks the selected word aloud, spells it letter by letter,
then speaks it aloud again. If you do not have a word selected to
spell, Open Book notifies you.
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Spell Word Phonetically [Shift+F3]: Select this menu item to
spell the word the cursor is on phonetically, using military spelling.
When you select this item, Open Book spells the selected word
using names, such as Alpha, Bravo and Charlie, for the letters (in
this case A, B and C).

Word Count [Shift+F7, Shift+Control+3 (think of it as
Control+#)]: Select this menu item to count the words in your
current document. When you select Word Count, Open Book
opens a dialog box that tells you the number of words in the
document.

Dictionary [Control+D, F8]: Select this menu item to open the
dictionary. You can look up the meaning of a word by selecting
the word, then selecting Dictionary. When you select Dictionary,
Open Book opens the Dictionary dialog box, announces the
selected word to be defined, and begins reading the definition.

Definition field: gives the definition of the selected word. To
read through at your own pace, use the arrow keys. You cannot
modify this field.

Show Expanded Definition and Etymology check box: tells
you whether this box is checked. When this box is checked,
Open Book gives you the most comprehensive definition,
including supplemental or related words. When unchecked,
Open Book gives you the basic definition of the word.

Switch to Thesaurus button: shifts you into the thesaurus
feature.

Close button: closes the dialog box.

Selected Word edit field: indicates the selected word. You
can also type a word to be defined into this field, then press
Enter. Open Book will give the definition of the new word in the
“Definition” field.
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Thesaurus [Control+T, Shift+F8]: Select this item to open the
thesaurus. You can look up a word’s synonym by selecting the
word, then selecting Thesaurus. When you select Thesaurus,
Open Book opens the Thesaurus dialog box. Open Book gives a
list of synonyms in the large Edit Field below “Synonyms.” When
you select Thesaurus, Open Book opens the Thesaurus dialog
box, announces the selected word, and begins reading a list of
synonyms.

Synonyms field: lists synonyms for the selected word. To
read through at your own pace, use the arrow keys. You cannot
modify this field.

Switch to Dictionary button: shifts you into the dictionary
feature.

Close button: closes the dialog box.

Selected Word edit field: indicates the selected word. You
can also type a word into this field, then press Enter. Open
Book will list the synonyms of the new word in the “Synonyms”
field.

Key Settings [F11]: Select this menu item to change the keypad
key assignments. To give you greater flexibility, users of screen
access programs such as Jaws and Window-Eyes can reprogram
the keypad keys to conform to the screen access key
assignments. For more information on the available functions and
key assignments, see the KEYS.INI file placed in your Ruby
directory.

When you start Open Book, this menu item is set to use Open
Book key settings. To select the alternate key settings you
designated in the KEYS.INI file, open the menu and move to Key
Settings. Open Book will announce the change in your settings.
To return to the Open Book settings, once again open the Tools
menu and move to Key Settings. Note: frequent users may find
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using the F11 key a more convenient way to cycle between the
key settings options.

Change Speech Driver: Select this item to use a different speech
synthesizer driver that you have previously installed. People
sometimes refer to this as changing speech drivers “on the fly.”
When you select Speech Drivers, Open Book opens the Speech
Driver list. Each speech driver you installed will be listed here. If
you only installed one speech driver, your current driver will be the
only one listed. Use the arrow keys to select a driver from the list.
When you close this list, Open Book will load the driver you
selected and begin using it.

Please note that you will only be able to switch among the list of
synthesizers that was created the last time you ran the Open
Book installation program. If you have more than one synthesizer
and you want them all to be available here, you should run the
Open Book installation program (Setup.exe) again and choose
“Synthesizer Driver Installation” from the options. You can install
as many synthesizers as you want, but you must have the driver
files for each (except ViaVoice Outloud, which is included with
Open Book). Also note that you cannot switch between different
Microsoft SAPI| synthesizers.

List of launchable programs: Select this menu item to launch
other Windows applications, such as Microsoft Word or Word
Perfect. You select the programs to be listed here during
installation. When you launch an application using this feature,
the new program opens and becomes the active program. Open
Book does not close, but remains open in the background.

To move between open programs: while holding down the Alt key,
press the Tab key to cycle through the available open
applications. You may need to press Tab more than once to cycle
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through all available programs. When you reach the application
you want to access, simply release both keys, and that application
will become the active one.

Settings Menu

This menu allows you to save, retrieve, or delete settings files, or
modify Open Book’s Speech, Visual, Scanning and General
settings. Whenever you start Open Book, it loads the settings file
called Default. If you want Open Book to load your favorite
settings each time you run the program, you should save them in
the Default settings file. We’'ll tell you how to do that below in the
description for the Save the Settings menu item.

The Speech Settings, Visual Settings, Scanning Settings, and
General Settings items all open expanded dialog boxes that are
called “property pages.” There is one page for each of the four
categories (Speech Settings, Visual Settings, Scanning Settings,
and General Settings). These pages include many different
settings options. In addition, there are four elements shared by all
four property pages. They are:

The Preview Box: this area, located on the right side of the
property pages, contains part of a famous literary speech. In
this area, Open Book demonstrates the speech and visual
changes that you have selected.

OK button: this button saves the selected settings and closes
the property pages. You can also do this by pressing the Enter
key.

Cancel button: this button closes the property pages without
saving the settings. You can also do this by pressing the
Escape key.



64 USING THE MENUS

Apply button: this button saves the selected settings but does
not close the property pages, allowing you to continue to make
modifications to other settings.

Once you open one property page, you can access any other
property page by using the tabs at the top of the property page
you're on. You can reach these headings by using the Tab key to
get to the title of your current property page, then using the Left
and Right arrow keys to move to other Property pages.

Save the Settings: Select this menu item to save the current
settings. When you want to keep the changes to your Speech,
Visual, Scanning, or General settings, you must save these
changes in a settings file. Otherwise, the next time you use Open
Book, it will return to the original settings. When you select Save
the Settings, Open Book opens the Select Settings File list. Use
the arrow keys to select a settings file or create a new settings
file. If you choose an existing settings file, Open Book will ask
you to confirm that you want to overwrite any previous settings
saved in that file. If you choose to create a new file, Open Book
will give you the opportunity to name that file.

If you want your favorite settings to be loaded each time you run
Open Book, save them in the Default settings file. This will
overwrite the Default settings with your favorite settings. Since
that file already exists, Open Book will ask you to confirm that you
want to overwrite the file. Don’t be afraid to do this. If you ever
want to go back to using the factory default settings, go to the
menu item called Retrieve the Settings, and select the file called
Factory default settings. That file cannot be changed or deleted,
so it will always be available to you.

Retrieve Settings: Select this menu item to retrieve saved
settings files, including the Default file (the one Open Book loads
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whenever it starts) and the Factory default settings file (the
original factory settings), as well as any settings files you have
named yourself. When you select Retrieve the Settings, Open
Book opens the Select Settings File list. Use the arrow keys to
select a settings file. Once you retrieve the file, the settings
saved in that file are activated.

Delete Settings: Select this menu item to delete saved settings
files. When you select Delete Settings, Open Book opens the
Select Settings File list. Use the arrow keys to select a settings
file. Open Book will ask you to confirm your deletions. Note: you
cannot delete the Default settings file.

Speech On [Control+F5]: Select this item to determine whether
Open Book speaks aloud or not. This menu item is checked by
default on startup. To check or uncheck this item, move to the
item on the menu, then press Enter.

Speech Settings: Select this item to open the Speech Settings
property page. This allows you to determine the type of voice,
volume, pitch, and inflection of Open Book’s speaking voice.

Voice Selection list field: to select the voice you wish modify,
type in your selection or use the arrow keys. You have three
options:

* Reading Voice, the voice Open Book uses to read aloud.

* Menu Voice, the voice Open Book uses to read menus.

* Emphasis Voice, the voice Open Book uses to read
emphasized text, like bold, underline and italics. Emphasis
text is not displayed in Open Book, but it is retained, so it can
be helpful to set your Emphasis voice slightly to be different
from the Reading voice. Some people like to set the
Emphasis voice to a slightly higher pitch or volume.
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Once you have selected the voice you wish to modify, use the

following options to alter that voice. Later, you can return to

Voice Selection, and choose another voice to modify.

Apply Settings to All Voices check box: tells you whether

this box is checked or unchecked. When this box is checked,

Open Book applies the changes you have just made to all three

voices (Reading, Menu, and Emphasis).

Voice Name list field: lists voices used by Open Book. The

speech software shipped with Open Book has five voice

options. (Other speech synthesizers may have a different

number of options.) Type in your selection or use the arrow

keys.

Voice Rate list field: to select how fast Open Book reads, type

the first digit of a number, or use the arrow keys.

Voice Volume list field: to select how loud Open Book reads,

type the first digit of a number, or use the arrow keys.

Voice Pitch list field: to select how high or low Open Book

reads, type the first digit of a number, or use the arrow keys.

Voice Inflection list field: to select how much inflection Open

Book uses, type the first digit of a number, or use the arrow

keys. This option may not be available with some speech

synthesizers.

Voice Punctuation list field: to determine how much

punctuation Open Book announces, type the first letter of your

selection, or use the arrow keys. Your choices are:

* All (Open Book speaks every period and comma).

* Some (Open Book speaks the less common punctuation but
not periods and commas).

* None (Open Book does not speak any punctuation).

This option may not be available with some speech

synthesizers.

Voice Language list field: to select which language Open

Book uses when reading, type in your selection or use the



USING THE MENUS 67

arrow keys. You must be using a multilingual speech

synthesizer, or this option will not be available.

Key Echo During Editing list field: to tell Open Book to speak

your typed keystrokes out loud when you are Edit Mode, type in

your selection or use the arrow keys. This spoken “echo” of
your keystrokes allows you to hear your typing as you type.

You have four options:

* Character speaks every keystroke as you type.

* \Word speaks only completed words, that is, it speaks the
word you just typed as soon as you type punctuation or a
space after it.

* Both speaks both the keystrokes as you type and the final
completed word after you type it. This is useful for beginning
typists or with material you are proofreading.

*  Off does not echo any keystrokes. Your typing will be silent,
except, of course, for the click, click, click of your keyboard.

Test button: tests the voice settings you have selected before

applying them. To stop testing, simply press Enter, or select

this button again.

Visual Settings: Select this item to open the Visual Settings
property page, to change the way Open Book presents text on the
screen. The Visual Settings property page has four sections:

Font determines the type and size of font used for text on the
page.

Font Name list field: to select the type of font used for text on
the page, use the arrow keys.

Font Size list field: to select the size of font used for text on
the page, use the arrow keys.

Colors determines the color of the on-screen text and
background, plus the cursor text and background.
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Text Color list field: to select the text color, use the arrow
keys.

Background Color list field: to select the color for the
background of your document (the part that’s not text), use the
arrow keys.

Cursor Text list field: to select the color for text within Open
Book’s cursor (or spotlight), use the arrow keys. Remember
that when you are in Read-only Mode, the cursor will spotlight
the current word. Therefore, the Cursor Text color will be the
color of the text in the current word. You can also change the
spotlight from word to line, sentence, or paragraph, using the
Movement Unit menu item in the General Settings property
page. Note that the default might not be the first color on the
list, so you may need to use the up arrow key to get to the color
of your choice.

Cursor Background Color list field: to select the color for the
background of text within Open Book’s cursor (or spotlight), use
the arrow keys. Remember that when you are in Read-only
Mode, the cursor will spotlight the current word. Therefore, the
Cursor Text color will be the color of the text in the current
word. You can also change the spotlight from word to line,
sentence, or paragraph, using the Movement Unit menu item in
the General Settings property page. In that case, the spotlight
will encompass the line, sentence, or paragraph as you read.
Note that the default might not be the first color on the list, so
you may need to use the up arrow key to get to the color of
your choice.

Side Margins: adjusts the amount of blank space at the right and
left sides of the page. In all cases, larger numbers means more
space.
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Left Margin list field: to increase or decrease the size of the
margin, use the arrow keys.

Right Margin list field: to increase or decrease the size of the
margin, use the arrow keys.

Extra Spacing: adjusts the amount of space between characters,
words, lines, and sentences. This can be an extremely valuable
feature for people with low vision. Increasing the amount of
space between these text elements can help you distinguish
between one word and the next, or can help you track to the next
line more easily. With all elements, the larger the number you
enter, the more space between the elements.

Character list field: to increase or decrease the amount of
space between characters, use the arrow keys.

Word list field: to increase or decrease the amount of space
between words, use the arrow keys.

Line list field: to increase or decrease the amount of space
between lines, use the arrow keys.

Sentence list field: to increase or decrease the amount of
space between sentences, use the arrow keys.

Scanning Settings: Select this item to open the Scanning
Options property page, which enables you to control the way
Open Book scans pages.

Scanning Mode list field: to select one of several different
ways to scan, use the arrow keys. Scanning Mode is one of
the most important and frequently used items, since you may
want to scan one page in Orientation Only, then the next in
Scan and Read, then a bunch more in Large Batch mode.
Therefore, we have given you other ways to get to the
Scanning Mode list while you are in your document. From
anywhere in the document, you can press Shift+F10 to bring up
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the Scanning Mode list. If you are a mouse user, simply click
the right mouse button.

Scanning Mode options include:

* Scan and Read lets you first scan a page, then read it. This
is the standard setting -- when you first use Open Book, your
scanning options are set to Scan and Read. This setting is
best for quickly reading short documents, such as letters and
recipes.

* Scan in Background lets you scan one page while reading
another. The document you are scanning may be the same
as the document you are reading, or you may scan into one
document, then open and read another. To scan and read
within the same document, choose Scan in Background,
then scan a page, and read it. While Open Book reads the
page, you'll hear a small musical tone, your signal that Open
Book is ready to scan another page. Place a second page
on the scanner, then press the Scan key. Open Book will
continue to read while the second page is being scanned. To
scan one document and read another, choose Scan in
Background. Begin scanning pages into a document and,
while Open Book is scanning, open another document and
read it. The musical tone will notify you to scan another
page. Scan in Background is the best setting when you want
to read and scan at the same time. However, this mode is
not recommended unless you have a hardware synthesizer,
such as DECtalk PC or DECtalk Express. Otherwise,
speech is interrupted during scanning.

* Large Batch lets you divide the scanning process into two
parts: Scanning the page, and Processing and Recognizing
the page. Scanning requires your participation to turn the
pages. But Processing and Recognition -- the lengthier
procedure -- can be done by the PC without your
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involvement. Using Large Batch, you can scan all the pages
of a large document -- like a book -- then instruct Open Book
to process the pages while you do something else. You
don’t have to be present during the processing step. Large
Batch gives you several options: you can scan a group of
pages, then immediately process them; scan a group, come
back later and scan more, then process them; or scan a
group, then process them at a later time. Large Batch is the
best setting for reading books and other large documents or
groups of pages. Use Large Batch on any big job to save
time. If you are using an Automatic Document Feeder
(ADF), the process is even more automated. You can place
batches of 20 to 25 pages in the ADF, and scan them as a
group. Please note that if you are using 2-page scanning
with an ADF, you must scan the backs of the pages in
reverse order so that Open Book can match them up
correctly.

Batch in Background allows you to begin Large Batch
scanning, and while you are scanning, open and read a
document. While reading the document, you will
occasionally be interrupted to hear the standard Large Batch
Scanning prompts. This mode is not recommended unless
you have a hardware synthesizer, such as DECtalk PC or
DECtalk Express. Otherwise, speech is interrupted during
scanning.

Express Batch is a simpler version of Large Batch
scanning. While Large Batch gives you prompts when it has
completed scanning and is ready for another page, Express
Batch skips these prompts. You must listen for the sound of
the scanner head reaching the bottom of the flatbed and
returning to the top. In those few seconds it takes to do this,
place a new page on the scanner. The scanner keeps
scanning, over and over again, until you press Escape. Just
as with Large Batch, once scanning is completed, Open
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Book will recognize the pages while you do something else.
You can also suspend scanning, or cancel the entire
Express Batch process. Express Batch is best used by a
person who's familiar with their scanner, and wants to scan a
large document quickly. Do not use this mode with an ADF.

* |mage Only scans the page and saves it as an image file,
without performing the recognition process. This setting is
useful if you wish to create an image file to be faxed later or
used as a graphic.

* Fax Files allows you to recognize files that you have
received via a fax card. For the best possible recognition, be
sure to get a fine fax image of 200 x 200 dpi, and save the
file in PCX, DCX or TIF format. When you choose this
scanning mode, you will need to tell Open Book where to
find the file you wish to recognize.

* Qrientation Only scans a page and determines its
orientation without proceeding to the recognition process.
This setting is useful when you are scanning a large
document. You can use Orientation Only to determine the
orientation of the first page, then set the Page Orientation to
the correct setting. This will speed up the scanning process.

Scanning Contrast list field: to control the dark-to-light

contrast ratio in the scanned document, use the arrow keys or

type the first letter of the selection. You have several choices:

*  Automatic Contrast. Open Book will individually evaluate
each page to determine the best contrast setting for
maximum accuracy. This is useful if you have mystery
pages to scan. This is the easiest setting but it adds to the
scanning time.

* Normal Contrast. This corresponds to a value of 127. This
setting will work for most books and memos, or anything else
that has reasonably good black print on white paper.

* Darken Page is useful when the print on the page is too
light. When Open Book reads a light page, letters seem to
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“break up.” An example of this is when Open Book reads “iii
instead of the letter “m.”

Lighten Page is a good choice if the letters are becoming
“glued together.” An example of this is when Open Book
reads the letter “m” instead of the letters “r" and “n.”

The Custom contrast choices include a series of numbers
from 0 to 255. Custom contrast settings can increase
accuracy if you have a page that is outside the range of the
other options. Low numbers make it darker, and high
numbers make it lighter. The Normal setting corresponds to

the value 127.

Page Orientation list field: to select the orientation of the
page on the scanner, use the arrow keys. While the Automatic
setting is usually best, if you are doing a number of pages for
which you already know the orientation, using the correct
orientation setting will speed up the scanning process. You
have five orientation choices (the instructions are for HP
scanners -- other scanner orientations may vary):

*

Automatic lets Open Book determine which way the page is
situated on the scanner. This is the easiest setting but it can
add slightly to the scanning time.

Normal means the top of the page is flush with the rear edge
of the scanner’s glass plate.

Sideways means the top of the page is flush with the right
side of the scanner’s glass plate.

Upside-down means the top of the page is flush with the
front edge of the scanner’s glass plate.

Sideways Upside-down means the top of the page is flush
with the left side of the scanner’s glass plate.

Scanning Resolution list field: controls how fine the scanner
makes a picture of the page. Many scanners have a standard
setting of 300 dots per inch. However, if you are reading pages
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printed in very small type and have a scanner that can resolve
as finely as 400 dots per inch, you may see improved
recognition accuracy. For 400 dpi to be effective, your scanner
must have an optical resolution of at least 400 by 400 dip. An
optical resolution of 300 by 600 dpi is not adequate. The point
range for fonts with a 300 dpi scanner is 6 to 24 points; for a
400 dpi scanner, the range is 4 to 24 points. To select the
scanner resolution, use the arrow keys. Note: Depending
upon your scanner, you may have only one choice in this
menu.

Left Boundary edit field: type in the number representing the
size of the left boundary, in inches and fractions of an inch.
Open Book will ignore anything outside this boundary area.

Right Boundary edit field: type in the number representing
the size of the right boundary, in inches and fractions of an
inch. Open Book will ignore anything outside this boundary
area.

Top Boundary edit field: type in the number representing the
size of the top boundary, in inches and fractions of an inch.
Open Book will ignore anything outside this boundary area.

Bottom Boundary edit field: type in the number representing
the size of the bottom boundary, in inches and fractions of an
inch. Open Book will ignore anything outside this boundary
area.

A note about using scanning boundaries: these boundaries
determine how much of the page will be recognized, by
defining the distance from the side of the page, and telling
Open Book to ignore anything outside that boundary. The
standard setting for all four boundaries (left, right, top, and
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bottom) is zero, which means that the entire page will be
scanned and recognized. However, if you are reading a book
and wish to delete the header (which repeats the title of the
book on each page), try defining a top boundary of one inch.
You'll need to experiment on each book to get the correct
setting. Setting the boundary might also be useful when
reading utility or phone bills. If the amount due is always
located in the same spot, you could define boundaries to
recognize only that area.

Text Type list field: to choose between two options, use the
arrow keys. Your choices include Normal Text and Type-
written or Dot Matrix Text. Pages printed on a Dot Matrix
printer or on a typewriter that doesn’t use proportional spacing
may not scan clearly. Selecting Typewritten or Dot Matrix Text
may help Open Book to read these pages more successfully.

Image Format list field: this is the format Open Book should
use to save an image you scan using the Image Only scanning
mode. Your choices include:

PCX

TIFF G3

TIFF G3 Modified

TIFF G4

TIFF Packbits

TIFF Uncompressed

* ¥ K K X ¥

Recognition Language list field: to choose which language
Open Book uses to recognize text, use the arrow keys. This
option is useful if the document you are using has text that
contains accent marks, umlauts, or other characters unique to
a particular language.
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Recognize columns check box: determines how Open Book
will scan, save, and present your document for reading. When
Recognize Columns is checked, Open Book saves and reads
all of column one first, then column two, and so on. If it
encounters tables, Open Book is smart enough to automatically
present them properly. When Recognize Columns is not
checked, Open Book will scan, save, and present the entire
page as though there are no columns. Most of the time column
recognition is the best choice. When you start Open Book, this
box is checked and Recognize Columns is on.

Color Scanning check box: determines whether Open Book
scans in color or in black and white. When checked, Open
Book will scan all colored text, art, and photographs in color. [f
you do not have a color scanner installed, Open Book will tell
you that color scanning is not possible. Color scanning and
recognition is a much slower process than the standard black-
and-white scanning, so we recommend that you only use this
item when you know you have something you want to save in
its original color presentation. Additionally, the results of Color
Scanning are only apparent while you are in Exact View, so you
must have Exact View checked to use Color Scanning. Also
note that you can only do color scanning at 300 dpi resolution.
When you start Open Book, this box is unchecked and Color
Scanning is off.

Keep Exact View check box: tells Open Book to save two
versions of any scanned page: the image file (the actual picture
of the page) and the text file (the recognized text from the
page). Since an image file can be very large, we recommend
that you only save this version of the page if you will be reading
the page in Exact View. When you start Open Book, this box is
unchecked and Keep Exact View is off.
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2-Page Scanning check box: allows Open Book to scan two
side-by-side pages of an open paperback book (or other book
in which both facing pages fit on the scanner) in a single scan.
Open Book will automatically read the first page first, then read
the second page. When you start Open Book, this box is
unchecked and 2-Page Scanning is off. This setting lets Open
Book do even better when scanning an open book!

De-skew check box: corrects as much as ten degrees of skew
in a crooked page, straightening up to three quarters of an inch
for a standard eight-and-a-half inch page. Use this option if
you are concerned that the page is on the scanner slightly
crooked, or skewed. It is also helpful when reading documents
that have been photocopied, since the text may not be perfectly
straight on the page. However, de-skewing will add a few
seconds to the scan time. When you start Open Book, this box
is checked and De-Skew is on.

De-speckle check box: corrects for a page that doesn’t have a
clean, clear background, such as a page that has been
photocopied several times, newspapers, or text on paper with
speckled shading on it, such as colored newsprint or
magazines. When you start Open Book, this box is checked
and De-Speckle is on.

White on Black check box: allows Open Book to scan and
recognize white text on a black background. This is useful
when reading packaged food boxes or magazines that often
use light text on a dark background for emphasis. When you
start Open Book, this box is checked and White on Black is on.

Language Analyst check box: improves accuracy on difficult
pages. However, this feature may slow the recognition
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process. When you start Open Book, this box is checked and
Language Analyst is on.

Emphasis Text check box: tells Open Book to indicate words
that were emphasized on the original page -- printed bold, or
with italics or underlining -- by using a different voice. Once
you select Emphasis Text, you should also modify the
Emphasis Voice on the Voice Settings Properties page, so that
the voice Open Book uses will sound different from the
Reading or Menu voices. Note that even if you have Emphasis
Text off, Open Book will still retain these attributes and export
them when you save the document for word processing. When
you start Open Book, this box is unchecked and Emphasis Text
is off.

Uncertain Text check box: tells Open Book to indicate when it
encounters a word or character it is unsure about by using the
Uncertain Text Marker (see next item). When you start Open
Book, this box is unchecked and Uncertain Text is off.

Uncertain Text Marker edit field: to designate a specific
character, such as an asterisk, that will be spoken when Open
Book finds a word or character it is unsure about, type the
character into the box. When you start Open Book, Uncertain
Text is set to Asterisk (*).

Express Batch Delay list field: to set the amount of time
between one scan and the next when scanning in Express
Batch, use the arrow keys to choose between 0 and 5. A larger
number gives you more time to turn the pages. When you start
Open Book, Express Batch Delay is set to 4.

General Settings: Select this item to open the Reading Options
property page, to change Open Book’s general settings.
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Movement Unit list field: this determines the amount of text to
be spotlighted in the cursor area. Use the arrows to choose
Word, Sentence, Line, or Paragraph. When you then use the
Speak key to have Open Book read continuously, the spotlight
cursor will highlight the unit as Open Book reads to you. Open
Book will not stop or pause at the end of each Movement Unit.
If you want Open Book to read Unit by Unit, use the Control key
with the right arrow key. Open Book will then stop at after each
Unit and wait for you to press Control plus right arrow again.
This is a useful way to review text for readability.

Tones check box: controls the beeps that are heard when
Open Book is scanning. When you start Open Book, this box is
checked and Tones are on.

Progress Messages check box: controls the messages that
Open Book speaks when it is recognizing the page. When you
start Open Book, this box is checked and Progress Messages
are on.

Announce Shortcut Keys check box: announces the menu
shortcut keys (for example, Control+O for Open in the File
menu) after each applicable menu item. This helps you learn
these shortcuts. When you start Open Book, this box is
checked and Announce Shortcut Keys is off.

Always Start in Edit Mode check box: When this item is
checked, Open Book is in Edit Mode whenever it is run. When
it is unchecked, Open Book starts in Read-only Mode. Many
beginning computer users will want to start in Read-only Mode,
only switching to Edit Mode when they want to edit something.
Other users will always want to stay in Edit Mode. Regardless
of which mode you start in, you can always switch from one
mode to the other. Use the Spacebar to check or uncheck this
item. When you start Open Book, this box is unchecked, so
you will start in Read-only Mode.
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Menu Level list field: allows you to choose between Beginner

and Advanced menu levels when using the Classic menu

system. This option only applies to the Classic menu system.

It has two options:

* Beginner level is very straightforward and easy to learn, but
has a limited number of choices.

* Advanced level includes more complex options.

Buckscan Currency edit field: allows you to choose whether

Buckscan will scan and identify American or Canadian currency

(Buckscan is found in the Scan menu). The default is

American currency.

Window Menu

This menu allows you to work with more than one document at a
time, or work in more than one application at a time.

New Window: Select this menu item and Open Book opens
another copy of the current document. This allows you to work in
two parts of the same document simultaneously, with changes
made affecting all open versions of the document. A very useful
application of this feature is to have the Exact View and the Text
View of the document open at the same time. You can move
back and forth between the two with ease. Note that if you edit
the Text View, those edits will not show up on the Exact View.
When you save or close any one of the open versions of the
document, you save or close all of them.

List of open files: Select this menu item to determine which open
document is currently on the screen. When you select the
number of the file, the new document is displayed on the screen.
The previously displayed document is still open, but not
displayed.
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Help Menu

This menu gives you access to information for learning and using
Open Book.

Help Topics [F1, keypad minus]: Select this item to open the
Help Topics list and read the Open Book manual on-line. When
you select Help Topics, Open Book presents a list of the manual
chapters. Use the arrow keys to select the topic you want to open
and read.

Once you open the Help file, Open Book treats the file just like
any other text file. You can save or print a copy of the Help file.

About Open Book: This item displays the program name, version
number and copyright information.

Windows Command Menu

In addition to the Open Book menus, the menu bar contains
additional standard Window items.

Caption Buttons

The small buttons located at the top right corner of the screen are
the standard Windows icons for minimize, maximize, and close. If
you press these icons while Open Book is open, you can
minimize or maximize how much of Open Book is displayed on
the screen, or close Open Book.

Document System Menu
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When you press the Alt key, Open Book takes you to the menu
bar to the Document System Menu. The Document System Menu
includes standard Windows commands that allow you to control
the documents you have open.

* Restore a document window to its original size.

* Move allows you to reposition a minimized document window
on the screen.

*  Size allows you to change the size of a minimized document
window.

* Minimize displays the current document on the screen in a
smaller window.

* Maximize displays the current document in a full-screen
window.

* Close closes the current document.

* Next switches you to the next document.

Application System Menu

Pressing the left arrow key while on the Document System Menu
takes you to an additional menu, located on the Windows
command bar at the top of the screen. This menu, the Application
System Menu, includes standard Windows commands that allow
you to control the applications you have open, including Open
Book:

* Restores a application window to its original size.

* Move allows you to reposition a minimized application window
on the screen.

* Size allows you to change the size of an minimized application
window.

* Minimize displays the current application on the screen in a
smaller window.
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* Maximize displays the current application in a full-screen
window.

* Close closes the current application.
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USING THE CLASSIC MENUS

This manual documents Open Book: the Ruby Edition as a
Windows program, using a standard Windows menu structure and
dialog boxes. However, if you used a previous version of Open
Book, you may wish to continue using the Classic-style Open
Book menus. You should be aware that most of Open Book’s
new features are only available through the Windows menu
structure, including the Edit features. Other items may operate
differently in Classic menus. The next section will list the Classic
menu items, in order, along with a description and the location for
the corresponding item on the Windows menus.

As a Classic menu user, you may also want to continue

controlling Open Book using the using keypad keys. For more
information using keypad keys, see the next Using Hotkeys.

The Classic Menus: Advanced menu level

Read a Document (File menu: Open) -- this option opens and
reads a previously named document.

Create a New Document -- this option creates a new document.
You can then scan pages into it.

Scanning Options (Settings menu: Scanning Settings) -- this
menu controls how Open Book scans. There are several choices
on this menu.

Scanning Mode -- this option gives several ways to control the
scanning process. Your choices are:

85
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Scan and Read -- this is the standard mode: Open Book
scans the page, then reads it aloud.

Scan in Background -- this mode scans one page while you
are reading another.

Large Batch -- this mode divides the scanning process into
Scanning, the step that requires your participation to turn the
pages and Recognition, the step that takes more time, but
can be performed while you do something else.

Batch in Background -- this mode allows you to scan a series
of pages using Large Batch mode, and while you are
scanning, read another document.

Express Batch -- Similar to Large Batch, this mode skips the
scanning prompts, allowing you to listen for the sound of the
scanner head reaching the bottom of the flatbed, and
returning to the top.

Image Only -- this mode scans a page and saves it as an
image file, without performing the recognition process.

Fax Files -- this mode performs the recognition process on
Fax or other image files.

Two Page (Note: this item is new to the Classic Menus) --
this mode scans two side-by-side pages of an open book in
a single scan.

Orientation only -- This mode scans a page, and determines
its orientation.

Scanning Contrast -- this option allows you to control the level
of contrast in the scanned page. Your choices are:
Automatic Contrast
Normal Contrast
Darken Page
Lighten Page
Custom Contrast
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Page Orientation -- this option allows you to select how Open
Book will handle pages that are upside-down or sideways.
Your choices are:

Automatic

Normal

Sideways

Upside Down

Sideways Upside Down

Scanning Boundaries -- this option specifies which portion of
the page should be recognized, by defining the distance from a
specific side of the page, and telling Open Book to ignore
anything outside the boundary area. You can control four
boundaries:

Left Boundary

Right Boundary

Top Boundary

Bottom Boundary

Scanning Resolution -- this option controls how fine a picture of
the page is made by the scanner. Your choices are:

300 dots per inch

400 dots per inch

Text De-skew -- this option determines whether the scanner will
compensate for up to 10 degrees of skew on a page. Your
choices are: On/Off

Language Analyst -- this option improves the quality of text
recognition on difficult pages. Your choices are: On/Off

ScanFix -- this option helps get the best scan possible by
performing additional work on the scanned images. Your
choices are: On/Off
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Text Type -- this option allows you to choose between two
types of print formats. Your choices are:

Normal text

Typewriter or Dot matrix

Text Flags (Note that in Windows menus, Bold, Italics, and
Underline are grouped under the term Emphasis) -- this
option, when used with a speech synthesizer, tells Open Book
to indicate words that were emphasized on the original page by
using a different voice for “Bold,” “Italic,” Underlined,” or
“Uncertain text.” Your choices are:

Bold text - On/Off

ltalic text - On/Off

Underlined text - On/Off

Uncertain text - On/Off

Uncertain text flag -- This option allows you to designate a

specific character, such as an asterisk, that will be spoken

when Open Book finds a word or character it is unsure

about.

Image Format -- This option allows you to choose into which
format a scanned image will be saved. Most Open Book users
will use this setting to create Fax images. Your choices are:

PCX

TIFF G3 Modified

TIFF G3

TIFF G4

TIFF Packbits

TIFF Uncompressed

Recognition Language -- this option lets you choose which
language to use when recognizing text.
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Library (File menu: Library) -- this menu allows you to create
new documents, open or close them, save them, delete them, or
open and read document files from many popular word
processing programs. There are several choices on this menu.

Read a Document -- this option opens and reads a previously
named document.

Create a New Document -- this option creates a new document
and then scans pages into it immediately.

Close Document -- this option closes a named document.
Save Document -- this option saves and names a document.
Convert Document -- this option converts an Open Book
document to a PC word processor, ASCII or PC spreadsheet
format.

Delete a Document -- this option deletes a document.

Create a New Category -- this option creates and names new
categories.

Delete a Category -- this option removes obsolete categories.
Read a File -- this option reads many files on your hard or
floppy drive, including word processing, spreadsheet, and
ASCII files.

Reading Options -- this menu controls how Open Book reads the
page.

Go To Page (Edit Menu: Go To Page) -- this option moves to
a specified page in the document and begins reading.

Find Text (Edit Menu: Find) -- this option searches for and
locates a specified word or phrase in the document.

Movement Unit (Settings Menu: General Settings) -- this
option affects how the text is highlighted during reading. When
you use the Speak key to have Open Book read continuously,
the spotlight cursor will highlight the unit as Open Book reads
to you. Open Book will not stop or pause at the end of each
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Movement Unit. If you want Open Book to read Unit by Unit,
use the Control key with the right arrow key. Open Book will
then stop at after each Unit and wait for you to press Control
plus right arrow again. This is a useful way to review text for
readability. Your choices are:

Word

Sentence

Line

Paragraph

Speech (Settings Menu: Speech Settings) -- this option lets
you control whether Open Book speaks or not. Your choices

are:

Text -- On/Off
Menus -- On/Off

Voice Settings (Settings Menu: Speech Settings) -- this
option changes the voice rate, pitch, or voice used for the three
voices. Each voice has the following choices:

Voice Rate -- this option changes how fast Open Book
speaks.

Voice Volume -- this option changes how loud Open Book
speaks.

Voice Pitch -- this option changes how high or low Open
Book speaks.

Voice Tone -- this option changes how much inflection
Open Book uses when speaking.

Punctuation Announcement -- this option determines how
much of the punctuation Open Book speaks.

Voice Selections -- this option selects the basic voice that
all the other settings modify.

Voice Language -- this option selects which language is
used for Open Book’s reading voice.

Voice Speech -- On/Off
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Visual Settings (Settings Menu: Visual Settings) -- this option
alters the way text is presented on the screen. You can modify
the following visual features:

Text Font

Text Size

Text Color

Background Color

Cursor Color

Cursor Background Color

Left Margin (Note: this item is new to the Classic Menus)

Right Margin (Note: this item is new to the Classic

Menus)

Extra Spacing Between Characters (Note: this item is new

to the Classic Menus)

Extra Spacing Between Words (Note: this item is new to

the Classic Menus)

Extra Spacing Between Lines (Note: this item is new to the

Classic Menus)

Extra Spacing Between Sentences (Note: this item is new

to the Classic Menus)

Open Book Options -- this menu controls various Open Book
features.

Menu Level (Settings Menu: General Settings) -- this option
changes Open Book’s level of difficulty. Your choices are:
Advanced menus
Beginner menus

Tones (Settings Menu: General Settings) -- this option
controls the beeps that Open Book makes while scanning.
Your choices are: On/Off
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Progress Messages (Settings Menu: General Settings) -- this
option controls the messages that Open Book speaks as it is
processing the page. Your choices are: On/Off

Announce Shortcut Keys (Settings Menu: General Settings) -
- this option determines whether Open Book announces the
keyboard shortcut immediately after speaking the menu option.
Your choices are: On/Off

Save the Settings (Settings Menu: Save the Settings) -- this
option allows Open Book to save current settings.

Retrieve the Settings (Settings Menu: Retrieve Settings) --
this option retrieves and activates any saved settings files,
including the Default file.

Delete the Settings (Settings Menu: Delete Settings) -- this
option deletes named settings files (except for Default).

Exit to Windows (File Menu: Exit) -- this option closes Open
Book and returns you to Windows. Your choices are: No, don't
exit or Yes, exit.

Quit and Shut Down (does not exist in Windows menus) --
this option closes Open Book, shuts down Windows, and turns
off your computer. Your choices are: No, don’t quit or Yes, quit.

Help (Help Menu) -- this menu offers several forms of help.

When you select Help, Open Book presents a list of the manual
chapters. Use the arrow keys to select the topic you want to open
and read.
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List of recently read files (File menu: list of recently read files) -
- this option lists of up to five of the most recently read
documents.

The Classic Menus: Beginner menu level

Note that the Beginner level contains only a very limited number
of menu topics. If you want to use other topics, you should go to
the Open Book Options, choose Menu Level, and select
Advanced Menus.

Reading Options-- this menu controls how Open Book reads the
page.

Go To Page (Edit Menu: Go To Page) -- this option moves to
a specified page in the document and begins reading.

Voice Settings (Settings Menu: Speech Settings) -- this
option changes the voice rate, pitch, or voice used for the
Reading Voice. You have the following choices:
Voice Rate -- this option changes how fast Open Book
speaks.
Voice Pitch -- this option changes how high or low Open
Book speaks.
Voice Selections -- this option selects the basic voice that
all the other settings modify.

Text Size (Settings Menu: Visual Settings) -- this option
alters the size of the text presented on the screen.

Open Book Options -- this menu controls various Open Book
features.
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Menu Level (Settings Menu: General Settings) -- this option
changes Open Book’s level of difficulty. Your choices are:
Advanced menus
Beginner menus

Save the Settings (Settings Menu: Save the Settings) -- this
option allows Open Book to save current voice settings.

Exit to Windows (File Menu: EXxit) -- this option closes Open
Book and returns you to Windows. Your choices are: No, don’t
exit or Yes, exit.

Quit and Shut Down (does not exist in Windows menus) --
this option closes Open Book, shuts down Windows, and turns
off your computer. Your choices are: No, don’t quit or Yes, quit.

Help (Help Menu) -- this menu offers several forms of help.
Select this item to open the Help Topics list and read the Open
Book manual on-line. When you select Help Topics, Open Book
presents a list of the manual chapters. Use the arrow keys to
select the topic you want to open and read.
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In addition to using the Alt key plus the various assigned shortcut
keys listed on the menus, you can access most of Open Book’s
features using hotkeys or key combinations. Many users find

using hotkeys faster and more efficient.

In the following section,

the hotkeys will be listed in two ways: first, alphabetically by

function; then in key order.

Function Keys

The function keys, which are lined up from left to right at the top of
the keyboard, activate the following Open Book features:

Alphabetical listing by function

Bookmark, delete
Bookmark, go to
Bookmark, insert
Change Key Settings

Dictionary

Help
Help, context-sensitive

Open Book Classic Menu toggle On/Off

Phonetic Spelling

95

Shift+Control+F9
F9

Control+F9

F11

F8

F1
Shift+F1

F2

Shift+F3
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Say Word F3

Scan F4
Scanning Status Shift+F4
Speak F10 or F12
Speech toggle On/Off Control+F5
Spell Check F7

Spell Word Control+F3
Status (Classic menu status line information) Shift+Control+F10
Status Bar toggle On/Off Control+F6
Thesaurus Shift+F8
Word Count Shift+F7

Listing in key order

F1 Help

Shift+F1 Context-sensitive help

F2 Open Book Classic Menu toggle On/Off
F3 Say Word

Control+F3 Spell Word (also press F3 a second time)
Shift+F3 Spell Word Phonetically (also F3 third time)
F4 Scan

Control+F5 Speech toggle On/Off

Control+F6 Status Bar toggle On/Off

F7 Spell Check

Shift+F7 Word Count

F8 Dictionary
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Shift+F8 Thesaurus
F9 Go To Bookmark
Shift+Control+F9 Delete Bookmark
Control+F9 Insert Bookmark
F10 Speak (Read)
Shift+Control+F10 Read Status Bar
F11 Change Key Settings
F12 Speak (Read)

Control key combinations

The Control key (Ctrl), when used in combination with other
keyboard keys, can also activate Open Book menu features.
Many of these hotkeys are also standard Microsoft Windows
editing and file management key combinations.

Alphabetical listing by function

Bookmark, insert Control+F9
Buckscan money identifier Control+M
Close Control+W
Copy Control+C

Cut Control+X
Delete Page Control+Delete
Dictionary Control+D

Document Properties Control+R



98 USING HHOTKEY

Edit Mode/Read-only Mode toggle Control+E

Find
GoTo

Insert Bookmark
Insert Page Break

Key Describer toggle On/Off
New
Open

Page, delete

Page break, insert
Paste

Print

Properties (document)

Read (speak) entire dialog box
Reading speed, decrease
Reading speed, increase
Replace

Save

Select All

Speech toggle On/Off
Spell Word

Spell Word Phonetically
Status Bar (read)

Status Bar toggle On/Off

Thesaurus

Control+F
Control+G

Control+F9
Control+Enter

Control+/ (slash key)
Control+N
Control+O

Control+Delete
Control+Enter
Control+V
Control+P
Control+R

Control+B
Control+1

Control+2
Control+H

Control+S
Control+A
Control+F5
Control+L
Shift+Control+L
Shift+Control+F10
Control+F6

Control+T
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Undo Control+Z

Word Count Shift+Control+3 (think of it as
Ctrl+#)
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Complete Hotkey list

Following is a complete alphabetical list of Open Book functions.

Bookmark, go to
Bookmark, insert
Bookmark, delete
Buckscan money identifier

Change Key Settings
Classic menus toggle On/Off
Close

Context-sensitive Help

Copy text

Cut text (Edit mode)

Delete Character

Delete Bookmark

Delete Page Break

Delete Page

Dialog Box (read entire box)
Dictionary

Document Properties

Edit Mode/Read-Only Mode toggle

Find text

Go To Bookmark
Go To Page

Help
Help, context-sensitive help

F9

Control+F9
Shift+Control+F9
Control+M

F11

F2
Control+W
Shift+F1
Control+C
Control+X

Delete key

Shift+Control+F9
Shift+Control+Enter
Control+Delete or keypad Del
Control+B

Control+D or F8

Control+R

Control+E
Control+F

F9
Control+G

F1 or - (keypad minus)
Shift+- (minus key) or
Shift+F1
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Insert Bookmark
Insert Page Break

Key Describer toggle

Menu key (Classic menus)
New File

Open File

Page Break, insert

Page Break, delete

Paste text (Edit mode)
Print

Properties (of open document)

Read (speak) the entire dialog box

Read Status Bar

Reading speed -- decrease

Reading speed -- increase
Replace text (Edit Mode)

Save

Scan (only in Read-only Mode)

Scan (in Edit Mode)
Scanning Status

Select All text (Edit Mode)
Speak

Speech toggle On/Off
Spell Check

Spell Word

Control+F9
Control+Enter

Control+/ (slash key) or
keypad 1

NumLock
Control+N
Control+O

Control+Enter
Shift+Control+Enter
Control+V
Control+P
Control+R

Control+B
Shift+Control+F10
Control+1
Control+2
Control+H

Control+S

Spacebar, F4, or keypad Ins

F4 or keypad Ins

Shift+F4 or keypad / (slash)

Control+A

F10, F12, or keypad Enter

Control+F5

F7 or Control+K

Control+L, F3 twice, or
keypad 5 twice
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Spell Word Phonetically Shift+Control+L, F3 third time,
or keypad 5 third time

Status Bar (read) Shift+Control+F10

Status Bar toggle On/Off Control+F6

Thesaurus Control+T or Shift+F8

Undo Control+Z

Where Am | Shift+Control+/ or keypad 7

Word Count Shift+Control+3 or Shift+F7

Using the Keypad on a portable PC

You can use Open Book on a portable notebook or laptop
computer. However, most portable computers do not have
standard 17-key keypads. We have therefore assigned alternate
keys to the Open Book keypad functions.

The F2 key is the Menu key. This key activates the menus that
allow you to choose different options and change Open Book’s
settings. A toggle key.

F4 or the Spacebar is the Scan key. This key starts or stops
scanning.

Control+Delete is the Delete Page key. This key deletes the
current page you are reading.

F10 or F12 is the Speak key. This key starts and stops reading,
interrupts speech, or repeats the current item in a menu or dialog
box.
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Enter is the Select key. This key selects the current choice, if
you are in a menu or are answering a question that Open Book
has posed. Note that the Enter key does not perform the say
word, spell word, spell word phonetically functions on a laptop.
To perform these functions, use F3.

The Esc key is the Escape key. This key exits the current
activity or allows you to leave a menu or Help when you are
finished with it.

Control+F12 is the Key Describer. This key describes the
function of the other keys. Press this key and the other keys
become inactive; then press any key and it will announce its
name. A toggle key.

Shift+Control+F12 is the Where Am I? key. This key explains
where you are in the reading process or in the menus.

F1 is the Help key. This key offers a detailed explanation to help
you decide what to do at any given point, and describes your
options. A toggle key.

Control+1 and Control+2 (the 1 and 2 above the letter keys)
are the Voice Rate keys. You can also use the Windows menus
to change the voice rate. The command sequence is Alt+G for
Settings, G for the General Settings, then Alt+R for Rate, then use
the arrow keys to select the rate you want.

Shift+F4 is the Scanning Status key. This key indicates the
page progress information for a page that is currently being
scanned. If you are not scanning, it indicates that no page is
being scanned. A toggle key.
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The Up Arrow key is Move Up. This key moves you up one line
if you are reading a page, or up one choice if you are in a menu.

The Down Arrow key is Move Down. This key moves you down
one line if you are reading a page, or down one choice if you are
in a menu.

The Left Arrow key is Move Left. This key moves you back a
word while you are reading. If you have changed the Movement
Unit, Move Left may move you back a letter, a sentence, a line, or
a paragraph.

The Right Arrow key is Move Right. This key moves you
forward a word while you are reading. If you have changed the
Movement Unit, move right may move you forward a letter, a
sentence, a line, or a paragraph.

The Page Up key is Page Up. This key moves to the previous
page in the document (if there is one).

The Page Down key is Page Down. This key moves to the next
page in the document (if there is one).
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If you are having a problem using Open Book, your Arkenstone

dealer and all of us at Arkenstone want to make sure that your

problem is solved as soon as possible. WWhen you need help, we
suggest you call your Arkenstone dealer first. Your dealer knows

you and your needs personally and should be able to help you

with most problems. If your dealer cannot help, or is unavailable,
please call us at Arkenstone. United States and Canadian callers
should use (800) 444-4443; other callers, please use 1+ (727)
803-8600. You can also contact us at
softwaresupport@FreedomScientific.com. We will be glad to assist you.

The following are some common questions about Open Book.

Questions About Scanning

After pressing the Scan button, Open Book doesn’t scan or
talk. What should | do?

Please note that some HP scanners may take up to 30 seconds

to warm up before scanning the first time in a session.

Subsequent scans will not have this delay.

1. Check to see if the scanneris on. You should be able to hear

the scanner “start up” when you press the power switch.

There is also a green indicator light in the front. When the

scanner is on, this light is illuminated.

Turn off Open Book and shut down your PC.

Check both the power cable and the scanner cable on the

back of the scanner. They must be on tight to work properly.

4. Next, follow the scanner cable to the back of your PC and
check the connection.

W N
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5. Also make sure that the scanner is unlocked. Scanners have
a locking mechanism that is engaged when the scanner is
shipped. You cannot run any scanning programs without
unlocking the mechanism, and you may break the scanner if
you repeatedly turn it on while locked. For more information
on how to unlock your scanner, see the instruction page
included with your scanner.

Restart your PC and Open Book

If this doesn’t solve your problem, please contact your dealer
or Arkenstone.

N o

What if | scan a page and it is not reading the columns
correctly?

Try turning off the Recognize Columns setting, then re-scan the
page. Although most pages scan and read best using the default
setting, Recognize Columns, other pages may improve with
Recognize Columns turned off.

Can | correct mistakes made by the scanner?

Yes, you can make changes and corrections while you are in Text
View, but not while you are in Exact View. You can use Open
Book’s editing capabilities to correct errors that you find in Text
View, then save the corrected document.

In Exact View, the scanner is actually taking a picture of the page,
which Open Book then displays in Exact View. You cannot
modify this picture.

How do | get better recognition from my scanner?
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You can start by using the Most Accurate Scanning setting in the
Scan Menu. This setting takes longer, but uses the highest
degree of scanning accuracy.

You can also try adjusting some of the settings in the Scanning
Settings property page, found on the Settings menu.

| am missing some letters in each line when | scan a book.
How do I fix this?

If you are missing letters from the beginning or end of each line,
you may not have the book correctly placed on the scanner.
Make sure to line up the edges of the book with the edge of the
scanner’s glass plate.

This result can also occur if you fail to press down firmly on the
book’s binding when you are scanning it.

Automatic Document Feeders

Can | use an automatic document feeder (ADF) with my
scanner?

Yes, but you must scan pages in the order you want them to
appear in your document. If you are scanning a 2-sided batch,
the backs of the pages should be scanned in reverse order.

If | purchase an ADF after | install Open Book, will | need to
reinstall the program?

You will not need to reinstall Open Book when you add an ADF to
your scanner. Exit Open Book, turn off your scanner and install
the ADF. Make sure to plug it into the scanner properly. When
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you turn on the scanner and run Open Book, the scanner will tell
the software that it now has an ADF.

To use the ADF, just place your pages in it. Open Book will
change how it prompts you to insure that you get complete use of
the ADF. You may also continue to use the flatbed.

Please note that if you have an HP5100 scanner purchased
before July, 1998, you will need a software upgrade from HP
before you can use the ADF.

How do | scan a document that has more pages than the ADF
can hold at one time?

Separate the stack of pages into smaller groups (typically 20 to 25
pages) and scan all of the “fronts” of each page in each group. If
you need to scan the “backs” of the pages, wait until prompted.
Select “Turn Pages Over” and scan all of the “backs” in each
group, starting with the last group, until all pages in the stack are
scanned. Open Book will automatically collate all pages.

How do | scan the next page when | am using the ADF?

After you have finished reading the page, press Scan. If there is
another page in the ADF, Open Book will scan the page
automatically.

What do | do if | get a paper jam with my automatic document
feeder?

Occasionally some scanners experience a paper jam in the
document feeder that halts everything -- Open Book stops reading
and says “Paper Jam.” If this situation occurs:
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Exit Open Book.

Turn off the PC and scanner, in that order.

Remove the paper from the scanner, making sure that no
paper clips or staples have gotten stuck in the automatic
document feeder.

Turn on the scanner first, then turn on your PC.

Start Open Book.

Resume scanning.

wh =

ook

Questions About Speech

Can | use Open Book to read without speech output?
Yes. Simply uncheck the Speech On item on the Settings menu.

What are the different voices | occasionally hear in the middle
of documents?

Open Book has three different voices:

* the Reading voice, used to read the document out loud;
* the Menu voice, used to read the menus out loud;

* the Emphasis voice, which indicates bold, italic or underlined
text;

If you hear a different voice in the middle of a document, it may
indicate some form of emphasis in the text. To learn which voices
are assigned to these options, go to the Speech Settings
properties page in the Settings menu.
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Questions About Documents and Folders

| can’t save my document to a floppy disk -- | get an error
message saying the disk doesn’t have enough space. What’s
the problem?

If the document is large -- several hundred pages -- the file may
simply be too big to copy to a floppy disk. Divide the document
into chunks, and save the chunks in separate, smaller files.

If you have chosen to save the Exact Page representation of your
documents, these files will take up much more space on the disk
than simple text files. A file that consists of many scanned pages
saved in Exact View may be too large to fit on a floppy disk.
There are several ways to reduce the size of a large file:

* Save the document as a .txt file -- this will delete the scanned
pages (the Exact View option), leaving only the Text View. The
resulting file will be much smaller.

* |f you know in advance that you want to save scanned pages to
a floppy disk, be sure to divide the project into smaller groups
of pages (1-10 pages per file). Scan and save one group into a
file, close it, and start a new one for the next group. When
you're done, you'll have all the pages scanned and saved, but
they’ll be separated into smaller files instead of stored in one
large file that may not fit on a floppy.

Why is some formatting lost when | view my word processor
file in Open Book?

When Open Book converts a word processing file into a Open
Book file, it gives you a great deal of control over the size, color
and spacing of the text, letting you display the text in a way that is
easiest to read. However, to give you that control, when a file is
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imported into Open Book, the formatting information from the
original file, such as bold, italics, underline, and font, is retained
but hidden. When you next save the file, the formatting is saved
along with it (unless you save to a .txt format). When you save a
file in its original format, most format attributes will be restored
and visible on screen. If formatting a file for output is critical, you
should use a word processing program.

What’s the best way to read a book?

The most efficient way to scan and read a book is to use Large
Batch as the Scanning Mode. This option is located on the
Scanning Settings properties page, in the Scanning menu. With
Large Batch, you scan all the pages, then go do something else
while Open Book is recognizing the pages. Later, when
recognition is complete, you can read the book.

If you are reading a paperback or other book in which both facing
pages fit on the scanner, then you should use 2-page scanning.

| scanned a book in batch mode and the pages are in reverse
order. Why?

You probably scanned the book from back to the front.
How do | read my phone bill?

Read your phone bill just as you would any other document. Be
sure to use Most Accurate Recognition. Because of the complex
layout of some bills, it also might help if you turn off Recognize
Columns. Finally, you might also try changing Text Type field to
“Typewritten or Dot Matrix Text” rather than “Normal Text.” You
can find this field on the Scanning Settings properties page in the
Scanning menu.
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What type of documents can’t | read with Open Book?

Open Book can scan -- take a picture of -- any page. However, it
can only convert and read aloud text that is printed or typewritten.
Open Book cannot convert and read handwritten or hand-printed
material. If there is a signature on a typewritten letter, Open Book
can read the letter aloud but not the signature. If the signature is
written over other printed words, for example, the closing
“Sincerely yours,” Open Book will not read the letters touched by
the signature correctly.

Open Book may have trouble reading some printed forms
because the text on a form is often surrounded by a box. Open
Book sometimes ignores text that is too close to vertical or
horizontal lines or surrounded by a box.

You'll probably have difficulty using Open Book to read box
scores on the sporting page or the stock market pages in the
newspaper. Even if Open Book reads most of the text correctly, it
may be hard to determine the meaning.

Other Questions About Open Book

Can | add words to the dictionary?

It depends on which dictionary you mean. The dictionary in the
Spell Checking program allows you to add your own spellings.
However, you cannot add words to the Houghton Mifflin American
Heritage College Dictionary that we use in the Dictionary and
Thesaurus menu items.
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Why do my printed pages look different from the page on the
screen?

The printed copy of your document will reflect the text size, font
and spacing choices selected on Visual Settings properties page
in the Settings menu. However, printed pages must conform to
the values set in the Print Setup dialog box (paper size, margins,
orientation). This may affect how the document fits on a physical
page. Because of this, sometimes the numbering of your printed
page will not match the numbering of the pages in your Open
Book document.

Can | self-pace my reading rate in Open Book?

Yes. Use the right or left arrow key to move the cursor to the next
or previous word and Open Book will read that word aloud. You
can also use the up or down arrow key to the previous or next
line.

Finally, you can use the arrow keys in combination with the
Control key (Control+ right arrow or Control+ left arrow) to move
to the next or previous Movement Unit increment (Word, Line,
Sentence, and Paragraph). Open Book will then read that
increment aloud.

Can | install Open Book on a network?
Open Book was designed to run from your computer's local hard

disk drive, not over a network. Site licenses are available for
multiple users.
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DETAILED INSTALLATION INSTRUCTIONS

Open Book’s Installation program talks, making it easy for you to
hear the prompts. When you first start the Installation program,
Open Book runs a test to see if you have a screen reader. If you
do, Open Book will then give you the choice of running the
program with your own screen reader, or using the standard Open
Book talking Installation program.

To navigate through the Installation dialog boxes, generally use
the Enter key, which selects the most likely option in each section.
You can also use the Tab key to move from element to element,
cycling through all the options until you return to the first one. To
move backwards through the elements, hold the Shift key, then
press the Tab key to cycle backward through the options.

To hear an entire dialog box read, hold down the Control key,
then press the B key. Once the dialog box begins speaking you
can let go of the B key. To make the Installation program stop
talking, simply press the Control key by itself.

Within each dialog box, you have different options, depending
upon whether the element is a button, check box, or field (see
below). However, at any point in the dialog box, you can press
Escape to cancel and close the dialog box, or Enter to choose an
item.

Buttons: Press the Enter key to activate the button, or the Tab
key to move to another element. Dialog boxes usually have three
buttons: Back, Next, and Cancel.

Check Box: Press the Spacebar to check the box; press it again
to uncheck the box. Once you have checked or unchecked the
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box, press the Tab key to move to another field or Enter to
advance to the next dialog box.

Edit Fields: Type the appropriate text in the field, then press the

Tab key to move to another field or Enter to advance to the next
dialog box.

Starting the Installation program

To begin the installation procedure:

* Turn on your PC.

* |nstall and turn on your scanner, making sure that it is
unlocked.

* Have your software serial number handy. The serial number is
located in two places: on the outside of the box and on the
outside of the plastic case that hold the Open Book CD.

* Place the Open Book CD in your CD-ROM drive. Open Book
automatically starts the installation process. (Note: if Open
Book is already installed, the automatic process will not start.)

If, for some reason, Open Book does not automatically start the
installation process, follow these steps:

1. With the Open Book CD in your CD-ROM drive, open the

Windows START menu on the task bar.

Select RUN.

In the Edit Field, type in the name of your CD drive (usually

d:\), followed by the word SETUP (for example, d:\setup).

4. Select the OK button in the RUN dialog box, or press the
Enter key.

2.
3.
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You can exit the Open Book Installation program at any time,
simply by selecting Cancel.

Prompts -- Typical Installation

Once installation begins, follow the prompts to install Open Book.
These prompts usually include:

Welcome

Open Book will warn you to close all open Windows programs,
then will load files needed to continue the installation.

User Information

Open Book will ask for your name, company name, and software
serial number.

Software License Agreement

Open Book will ask you to read and agree to the license
agreement.

Setup Type

Open Book will ask whether you want to do a typical or custom
installation.

“Typical” installs the standard files necessary to run Open Book,
Hewlett-Packard scanner drivers, and a software speech
synthesizer. If you wish to use a different scanner or speech
synthesizer, you must select the Custom installation.
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“Custom” gives you more control over where documents are
stored and which files are installed. It also allows you to install
other scanner and speech synthesizer drivers.

Unless you need to make detailed modifications, we recommend
that you choose the Typical installation.

Installing the Open Book files

Once you select Typical, Open Book will install all program files,
then give you the opportunity to read the README file. This file
gives up-to-date information about the software. When you are
finished reading the README file, press Alt+F4 to return to the
Installation Program. Open Book will then ask you to press Enter
to complete installation. In some cases, you may need to re-boot
your computer before you begin using Open Book.

If you have any difficulties running Open Book after you have

installed it, check the chapter in this manual titled Frequently
Asked Questions, to see if we address your problem.

Prompts -- Custom Installation

If you need more control over which components are installed and
where, choose “Custom Installation. Once you select Custom,
Open Book presents the following installation options:

Synthesizers



APPENDIX A: DETAILED INSTALLATION 119

Although Open Book includes its own software speech
synthesizer, Custom Installation lets you select one or more
speech synthesizers from a list. Make your choices by using the
Spacebar.

You can also install a separate speech synthesizer at a later time.
It is not necessary to have a speech synthesizer to install Open
Book.

All scanners other than ViaVoice Outloud, which is included with
Open Book, require their own hardware and/or software
installation. Consult your synthesizer’'s manual.

Scanners

Custom Installation allows you to select your scanner from a list.
You can also install a separate scanner at a later time. Note that
Accupage will not work correctly on Windows NT. If you are using
Windows NT, you must select “HP Flatbed Scanner” not “HP
Flatbed Scanner with Accupage.” You must also install the
scanner and its software before you can use the scanner with
Open Book. [t is not necessary to have a scanner to install Open
Book.

Launchable Applications

Open Book will identify certain launchable applications on your
hard drive, such as word processing programs and Grade 2
Braille transcription programs. If you choose, these applications
will appear on your Open Book menu, and you can open them
while using Open Book. You can also configure launchable
applications at a later time.

Destination Folders
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Open Book will ask you to confirm the proposed location for the
Open Book files on your hard drive. If you wish the files to be
saved to a different location, you can type that location in the
Destination edit field.

Review of Choices

Open Book will present you with a list of identified selections,
including speech synthesizers, scanners, launchable applications,
and file destinations, and ask you to confirm. If you wish to
change any of the selections, simply use the Back button to go
back to the appropriate dialog box, and make your changes.

Installing the Open Book files

Open Book will install all program files, then give you the
opportunity to read the README file. This file gives up-to-date
information about the software. When you are finished reading the
README file, press Alt+F4 to return to the Installation Program.
Open Book will then ask you to press Enter to complete
installation. In some cases, you may need to re-boot your
computer before you begin using Open Book.

If you have any difficulties running Open Book, check the chapter

titled Frequently Asked Questions, to see if we address your
problem.

Making changes to Open Book
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It's easy to make changes to Open Book, such as adding a

scanner or launchable programs. Place the Open Book CD in
your CD-ROM drive, then run the program called Setup following
the steps listed below.

1. With the Open Book CD in your CD-ROM drive, open the

Windows START menu on the task bar.

Select RUN.

In the Edit Field, type the name of your CD drive (usually d:\),

followed by the word SETUP (for example, d:\setup).

4. Select the OK button in the RUN dialog box, or press the
Enter key.

2.
3.

Once installation begins, Open Book presents a series of options,

including:

* Uninstall current version

*  Synthesizer driver installation

* Launchable application setup

*  Scanner installation

Make your selection, then follow the prompts.

How to Uninstall Open Book

There are two ways to uninstall Open Book.

If you wish to uninstall and then re-install Open Book, place the
Open Book CD in your CD-ROM drive. Then run the program
called Setup following the steps listed below.

1. With the Open Book CD in your CD-ROM drive, open the
Windows START menu on the task bar.
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Select RUN.

In the Edit Field, type the name of your CD drive (usually d:\),
followed by the word SETUP (for example, d:\setup).

4. Select the OK button in the RUN dialog box, or press the
Enter key.

W N

Open Book presents a series of options, including:

* Uninstall current version

*  Synthesizer driver installation
* Launchable application setup
*  Scanner installation

Select Uninstall and follow the prompts.

If you simply wish to uninstall Open Book and ViaVoice Outloud,
use the Add/Remove Programs feature in the Windows Control
Panel.
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